1 Overview: BlackBerry Enterprise Server Express ................................................................. 6
2 Planning a BlackBerry Enterprise Server Express installation ............................................. 7
   Installing all BlackBerry Enterprise Server Express components on one computer .......... 7
   Installing the BlackBerry Administration Service ................................................................. 8
   Installing the BlackBerry Attachment Service .................................................................. 8
   Installing the BlackBerry MDS Connection Service ........................................................... 9
   Installing the BlackBerry Router ....................................................................................... 10
3 Hardware requirements: BlackBerry Enterprise Server Express ...................................... 11
4 System requirements .......................................................................................................... 13
   System requirements: BlackBerry Enterprise Server Express ............................................ 13
   System requirements: BlackBerry Administration Service and BlackBerry Web Desktop Manager ................................................. 14
   System requirements: BlackBerry Enterprise Server Express databases ............................ 15
   System requirements: BlackBerry Attachment Service ......................................................... 17
   System requirements: BlackBerry MDS Connection Service .............................................. 18
   System requirements: BlackBerry Router ............................................................................ 19
   System requirements for your organization’s environment ............................................... 19
   System requirements: Computers for BlackBerry Web Desktop Manager and BlackBerry Administration Service users ......................................................... 20
   System requirements: Messaging server ............................................................................. 21
   System requirements: Firewall ........................................................................................... 22
   Supported features and environments ................................................................................ 22
   Unsupported environments ................................................................................................. 23
5 Preinstallation tasks ............................................................................................................. 25
   Configuring a Microsoft Exchange 2010 messaging environment ...................................... 25
      Create a Windows account that has a Microsoft Exchange 2010 mailbox ......................... 25
      Configure Microsoft Exchange 2010 permissions for the Windows account ................ 26
      Turn off client throttling in Microsoft Exchange 2010 ..................................................... 26
      Increase the maximum number of connections to the Address Book service in Microsoft Exchange 2010 .................................................. 27
      Configure a management role for Microsoft Exchange Web Services ........................... 27
      Configure the BlackBerry Enterprise Server Express to run without public folders .......... 28
      Permit meeting requests from outside of your organization when using Microsoft Exchange Web Services for Microsoft Exchange 2010 ................................................................. 28
   Configuring a Microsoft Exchange 2007 messaging environment ..................................... 29
      Create a Windows account that has a Microsoft Exchange 2007 mailbox ....................... 29
      Configure Microsoft Exchange 2007 permissions for the Windows account ................ 30
      Permit users to send email messages in a Microsoft Exchange environment ................ 30
6 Installing the BlackBerry Enterprise Server Express software

Prerequisites: Installing the BlackBerry Enterprise Server Express software .......................................................... 41
Install the BlackBerry Enterprise Server Express software ........................................................................................... 42
Install a BlackBerry Enterprise Server Express component on a computer that is separate from the computer that hosts
the BlackBerry Enterprise Server Express ......................................................................................................................... 45
Install a standalone BlackBerry Router ............................................................................................................................. 47
Test the connection from the BlackBerry Router to the BlackBerry Infrastructure ....................................................... 48

7 Postinstallation tasks ......................................................................................................................................................... 50
Test the BlackBerry Enterprise Server Express installation ........................................................................................... 50
Install the BlackBerry database notification system ........................................................................................................ 50
Best practice: Running the BlackBerry Enterprise Server Express ....................................................................................... 51
Configuring support for Unicode languages ................................................................................................................... 52
Configure support for Unicode languages .......................................................................................................................... 52
Change the character encoding that the BlackBerry Enterprise Server Express uses to send Unicode messages ........ 53
Configure support for Unicode text in calendars on BlackBerry devices in a Microsoft Exchange environment .......... 54
Configuring the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services .................................. 55
Prerequisites: Configuring the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services ........ 56
Configure the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services ................................ 56
Manage the BlackBerry Enterprise Server Express performance in a Microsoft Exchange 2010 environment ................. 57
Log in to the BlackBerry Administration Service for the first time ................................................................................... 58
There is a problem with this website’s security certificate ................................................................................................. 58
Configuring communication with distributed components ................................................................................................. 59
Connecting to a BlackBerry Attachment Service .................................................................................................................. 59
Connecting to a BlackBerry Router ..................................................................................................................................... 61
Restrict database permissions for the BlackBerry Attachment Service ............................................................................. 63
Configuring minimum Microsoft SQL Server permissions for the Windows account ......................................................... 64
Configure minimum Microsoft SQL Server permissions for the Windows account ............................................................... 64
Changing the BlackBerry Configuration Database ............................................................................................................. 65
Instructing users with personal BlackBerry devices to use the BlackBerry Desktop Software to manage personal and work data ............................................................................................................................................. 65

8 Adding or removing BlackBerry Enterprise Server Express components ................................................................. 66
Add or remove a BlackBerry Enterprise Server Express component ........................................................................... 67
Remove BlackBerry Enterprise Server Express component information from the BlackBerry Configuration Database .......... 70

9 Removing the BlackBerry Enterprise Server Express software .................................................................................. 71
Remove the BlackBerry Enterprise Server Express software .............................................................................................. 71
Delete registry keys .......................................................................................................................................................... 71
  BlackBerry Enterprise Server Express registry keys ..................................................................................................... 72
Removing the BlackBerry database notification system ..................................................................................................... 73
  Remove the BlackBerry database notification system from a BlackBerry Configuration Database ................................. 73
  Remove the BlackBerry database notification system from all BlackBerry Configuration Database instances .............. 73

10 Troubleshooting the BlackBerry Enterprise Server Express installation process ............................................................... 75
Failed to write License Key to the Database ....................................................................................................................... 75
Previous version detected but no database available ......................................................................................................... 75
A third-party tool did not install and the BlackBerry Enterprise Server Express setup application closed ....................... 76
The setup application did not prompt you to change or confirm the MAPI profile ...................................................... 76
You cannot determine the BlackBerry Attachment Connector that the BlackBerry Enterprise Server Express uses or the BlackBerry MDS Connection Service uses ........................................................................................................................................ 77
Users experience unexpected behavior with message lists and calendars on BlackBerry devices ................................. 78
Some BlackBerry Enterprise Server Express components do not start ........................................................................... 79
You cannot access the BlackBerry Administration Service ................................................................................................. 80
You cannot create a user account in the BlackBerry Administration Service ............................................................... 81
The BlackBerry Administration Service pool name is the same as the FQDN of the host computer ........................................ 81
The text in the license agreement is not readable .............................................................................................................. 82

11 Related resources ......................................................................................................................................................... 83

12 Glossary ................................................................................................................................................................. 84

13 Legal notice .............................................................................................................................................................. 86
Overview: BlackBerry Enterprise Server Express

The BlackBerry Enterprise Server Express is designed to be a secure, centralized link between an organization’s wireless network, communications software, applications, and BlackBerry smartphones. The BlackBerry Enterprise Server Express integrates with your organization’s existing infrastructure to provide smartphone users with mobile access to your organization’s resources.

The BlackBerry Enterprise Server Express supports smartphones that are provisioned for a BlackBerry Enterprise Server or for the BlackBerry Internet Service.

You can manage the BlackBerry Enterprise Server Express, smartphones, and user accounts using the BlackBerry Administration Service. You can access the BlackBerry Administration Service web application from any computer that can access the computer that hosts the BlackBerry Administration Service.

You can optionally install BlackBerry Mobile Fusion Studio in your organization’s environment to provide a simplified administrative console for your organization’s helpdesk administrators and an integrated view of the BlackBerry Enterprise Server Express and other MDM domains. For more information, visit http://www.blackberry.com/go/serverdocs to see the BlackBerry Mobile Fusion Studio Feature and Technical Overview.
Planning a BlackBerry Enterprise Server Express installation

You can install all BlackBerry Enterprise Server Express components on one computer, or you can install specific components on separate computers. You should consider any impact to system resources before you decide where to install the components.

You install all components on one computer if you do not plan to activate many BlackBerry devices, if you determine that the computer can manage the volume of traffic for the BlackBerry Enterprise Server Express components, and if it is acceptable that the computer has direct access to the Internet, without being located in the DMZ.

Installing all BlackBerry Enterprise Server Express components on one computer

You can install all the BlackBerry Enterprise Server Express components on the same computer.

During the installation process you can choose to install the BlackBerry Web Desktop Manager and the BlackBerry Administration Service with the BlackBerry Enterprise Server Express. All of the other BlackBerry Enterprise Server Express components are installed automatically when you install the BlackBerry Enterprise Server Express.

Related information
System requirements, 13
Preinstallation tasks, 25
Installing the BlackBerry Enterprise Server Express software, 41
Hardware requirements: BlackBerry Enterprise Server Express, 11
Installing the BlackBerry Administration Service

The BlackBerry Administration Service permits you to manage a BlackBerry Enterprise Server Express domain through a web-based application. A BlackBerry Enterprise Server Express domain consists of one BlackBerry Configuration Database and all BlackBerry Enterprise Server Express instances and remote components that use the BlackBerry Configuration Database.

You can install the BlackBerry Administration Service with other BlackBerry Enterprise Server Express components or by itself on a separate computer. You can install the BlackBerry Administration Service on a separate computer to limit the impact that the BlackBerry Administration Service might have on system resources and to prevent administrators in your organization from accessing any part of the computer that hosts the BlackBerry Enterprise Server Express. If you install the BlackBerry Administration Service before you install a BlackBerry Enterprise Server Express, the installation process can create and populate the BlackBerry Configuration Database.

When you install the BlackBerry Administration Service, you can install the BlackBerry Web Desktop Manager and select whether you want administrators to use Windows authentication or BlackBerry Administration Service authentication to log in to the BlackBerry Administration Service. You must verify that all administrators have access to the BlackBerry Administration Service web address (https://<computer_name>:<port>/webconsole/app).

Related information
Installing the BlackBerry Enterprise Server Express software, 41
System requirements for your organization’s environment, 19
System requirements: Computers for BlackBerry Web Desktop Manager and BlackBerry Administration Service users, 20
Hardware requirements: BlackBerry Enterprise Server Express, 11
System requirements: BlackBerry Administration Service and BlackBerry Web Desktop Manager, 14

Installing the BlackBerry Attachment Service

The BlackBerry Attachment Service converts supported attachments into a format that users can view on their BlackBerry devices. By default, the BlackBerry Enterprise Server Express includes the BlackBerry Attachment Service.

The BlackBerry Attachment Service might use increased system resources when it processes numerous conversion requests simultaneously. If you want to increase the number of conversion requests that can occur concurrently without
impacting message delivery, you can install a BlackBerry Attachment Service on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server Express.

You can connect multiple BlackBerry Enterprise Server Express instances and BlackBerry MDS Connection Service instances to a BlackBerry Attachment Service instance.

When you install the BlackBerry Attachment Service on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server Express, the installation process installs the BlackBerry Attachment Service and BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Attachment Service and restarts it if it stops responding.

Related information
Installing the BlackBerry Enterprise Server Express software, 41
Hardware requirements: BlackBerry Enterprise Server Express, 11
System requirements: BlackBerry Attachment Service, 17

Installing the BlackBerry MDS Connection Service

The BlackBerry MDS Connection Service provides users with access to online content and applications on your organization’s intranet or the Internet. By default, the BlackBerry Enterprise Server Express includes the BlackBerry MDS Connection Service.

The BlackBerry MDS Connection Service might use increased system resources when it processes content requests. If you want to minimize the impact this has on message delivery, you can install the BlackBerry MDS Connection Service by itself on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server Express.

You can connect multiple BlackBerry Enterprise Server Express instances to a BlackBerry MDS Connection Service instance.

When you install the BlackBerry MDS Connection Service on a separate computer, you must assign at least one BlackBerry Enterprise Server Express instance to it during the installation process. The BlackBerry MDS Connection Service uses the BlackBerry Enterprise Server Express information to connect to the BlackBerry Attachment Service.

When you install the BlackBerry MDS Connection Service on a separate computer, the installation process installs the BlackBerry MDS Connection Service and BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry MDS Connection Service and restarts it if it stops responding.

Related information
Installing the BlackBerry Enterprise Server Express software, 41
System requirements for your organization’s environment, 19
Hardware requirements: BlackBerry Enterprise Server Express, 11
System requirements: BlackBerry MDS Connection Service, 18
Installing the BlackBerry Router

The BlackBerry Router connects to the wireless network and sends data to and from BlackBerry devices.

You can install a BlackBerry Router with other BlackBerry Enterprise Server Express components or by itself on a separate computer. You can install the BlackBerry Router on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server Express if you want to install the BlackBerry Router in the DMZ.

You can connect multiple BlackBerry Enterprise Server Express instances to a BlackBerry Router instance.

If you install the BlackBerry Router on a separate computer, the installation process installs the BlackBerry Router and BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Router and restarts it if it stops responding.

Related information
Installing the BlackBerry Enterprise Server Express software, 41
System requirements: BlackBerry Router, 19
Hardware requirements: BlackBerry Enterprise Server Express, 11
Hardware requirements: BlackBerry Enterprise Server Express

The following are requirements for a BlackBerry Enterprise Server Express and the BlackBerry Enterprise Server Express components that you install on a single computer that uses Microsoft Exchange. The requirements are for an environment that includes users that receive 100 to 200 email messages each day.

You can improve the performance and reliability of the BlackBerry Enterprise Server Express by installing components on multiple computers. If you install all BlackBerry Enterprise Server Express components on the same computer as the messaging server, it is a best practice to support up to 75 BlackBerry device users only on the BlackBerry Enterprise Server Express. If you want to support more than 75 users on the BlackBerry Enterprise Server Express, it is a best practice to install the BlackBerry Enterprise Server Express components on computers that are separate from the computer that hosts the messaging server.

If your environment supports up to 1000 users, install the BlackBerry Configuration Database on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server Express. If your BlackBerry Enterprise Server Express environment supports up to 2000 users, install the BlackBerry Configuration Database and the BlackBerry Administration Service on computers that are separate from the computer that hosts the BlackBerry Enterprise Server Express.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| BlackBerry Enterprise Server Express that supports up to 75 users on the same server as Microsoft Exchange or Windows Small Business Server | • Visit [www.microsoft.com](http://www.microsoft.com) to see the requirements for Microsoft Exchange or Windows Small Business Server  
• Add 1.5 GB memory to the memory requirements for Microsoft Exchange or Windows Small Business Server  
• 150 MB disk space for the BlackBerry Enterprise Server Express  
• 400 MB disk space for the BlackBerry Administration Service  
• Approximately 2 MB per user each day for log files (100 email messages per user) |
| BlackBerry Enterprise Server Express that supports up to 200 users | • Single processor, 2.0 GHz Intel Xeon (two processors recommended)  
• 2 GB of memory  
• 64-bit operating system: Two 64 GB drives (minimum), RAID 1 |
<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
|      | • 32-bit operating system: Two 36 GB drives (minimum), RAID 1  
|      | • 150 MB disk space for the BlackBerry Enterprise Server Express  
|      | • 400 MB disk space for the BlackBerry Administration Service  
|      | • Approximately 2 MB per user each day for log files (100 email messages per user) |
| BlackBerry Enterprise Server Express that supports up to 500 users | • Two processors, 2.0 GHz Intel Xeon  
| | • 2 GB of memory  
| | • 64-bit operating system: Two 64 GB drives (minimum), RAID 1  
| | • 32-bit operating system: Two 36 GB drives (minimum), RAID 1  
| | • 150 MB disk space for the BlackBerry Enterprise Server Express  
| | • 400 MB disk space for the BlackBerry Administration Service  
| | • Approximately 2 MB per user each day for log files (100 email messages per user) |
| BlackBerry Enterprise Server Express that supports up to 1000 users | • Two processors, 2.0 GHz Intel Xeon  
| | • 3 GB of memory  
| | • 64-bit operating system: Two 64 GB drives (minimum), RAID 1  
| | • 32-bit operating system: Two 36 GB drives (minimum), RAID 1  
| | • 150 MB disk space for the BlackBerry Enterprise Server Express  
| | • 400 MB disk space for the BlackBerry Administration Service  
| | • Approximately 2 MB per user each day for log files (100 email messages per user) |
| BlackBerry Enterprise Server Express that supports up to 2000 users | • Two processors, 2.8 GHz Intel Xeon or two processors, 1.86 GHz Intel Xeon 5100 Series (Dual Core)  
| | • 6 GB of memory  
| | • 64-bit operating system: Two 64 GB drives (minimum), RAID 1 or four 64 GB drives (minimum), RAID 1+0  
| | • 32-bit operating system: Two 36 GB drives (minimum), RAID 1 or four 36 GB drives (minimum), RAID 1+0  
| | • 150 MB disk space for the BlackBerry Enterprise Server Express  
| | • 400 MB disk space for the BlackBerry Administration Service  
| | • Approximately 2 MB per user each day for log files (100 email messages per user) |
System requirements

System requirements: BlackBerry Enterprise Server Express

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2 SP1</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2003</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2008</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2011 Standard</td>
</tr>
<tr>
<td>Microsoft Exchange system tools</td>
<td>Any of the following system tools:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Exchange 2003 SP2 System Manager</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Exchange Server MAPI Client and CDO 1.2.1</td>
</tr>
<tr>
<td></td>
<td>To support Microsoft Exchange Server 2010, you must install version 6.5.8211.0 or later of the Microsoft Exchange Server MAPI Client and CDO 1.2.1.</td>
</tr>
<tr>
<td></td>
<td>For more information about the the versions of the Microsoft Exchange Server MAPI client and CDO 1.2.1 that are supported by the BlackBerry Enterprise Server Express, visit <a href="http://www.blackberry.com/go/compatibility">www.blackberry.com/go/compatibility</a> to see the BlackBerry Enterprise Server Express compatibility matrix.</td>
</tr>
<tr>
<td></td>
<td>For more information about installing MAPI and CDO patches on your organization’s BlackBerry Enterprise Server Express, visit support.microsoft.com to read article 917481 and visit <a href="http://www.blackberry.com/go/kbhelp">www.blackberry.com/go/kbhelp</a> to read article KB15779.</td>
</tr>
<tr>
<td>Item</td>
<td>Requirement</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Microsoft Exchange organization of the system tools for the messaging server</td>
<td>The same Microsoft Exchange organization that the messaging server uses</td>
</tr>
<tr>
<td>CDO library</td>
<td>To support the latest version of Microsoft Exchange Server in your organization's environment, the latest version of the CDO library that applies to the Microsoft Exchange Server version</td>
</tr>
<tr>
<td>Unicode support for calendars</td>
<td>To support Microsoft Exchange Server 2003, the following Microsoft hotfixes:</td>
</tr>
<tr>
<td></td>
<td>• 913643 on the messaging server</td>
</tr>
<tr>
<td></td>
<td>• 923537 on the computer that hosts the BlackBerry Enterprise Server Express</td>
</tr>
<tr>
<td>browser</td>
<td>Windows Internet Explorer 7.0 to 8.0 with language preferences configured to display encoded web pages</td>
</tr>
<tr>
<td>media player</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• if using Windows Server 2008, to support audio attachments, Windows Media Format SDK (for more information, visit msdn.microsoft.com and search Windows Media Format SDK)</td>
</tr>
<tr>
<td></td>
<td>• if using Windows Server 2003, to support audio attachments, Windows Media Player 9 or later</td>
</tr>
<tr>
<td>network proximity</td>
<td>A high-speed, switched connection between the BlackBerry Enterprise Server Express and messaging servers</td>
</tr>
<tr>
<td>File and Printer Sharing</td>
<td>If using Windows Server 2003, to permit the BlackBerry Controller to monitor BlackBerry Enterprise Server Express components, install File and Printer Sharing</td>
</tr>
<tr>
<td></td>
<td>For more information, see the documentation for Windows Server</td>
</tr>
</tbody>
</table>

**System requirements: BlackBerry Administration Service and BlackBerry Web Desktop Manager**

The following system requirements apply to the computer that you install the BlackBerry Administration Service and BlackBerry Web Desktop Manager on.
## System requirements

<table>
<thead>
<tr>
<th><strong>Item</strong></th>
<th><strong>Requirement</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2 SP1</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2003</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2008</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2011 Standard</td>
</tr>
<tr>
<td></td>
<td>• Microsoft hotfix 955839 installed on the computer that hosts the BlackBerry Administration Service and BlackBerry Web Desktop Manager</td>
</tr>
<tr>
<td>memory</td>
<td>A minimum 1.2 GB of memory</td>
</tr>
<tr>
<td>outgoing data connection</td>
<td>For the BlackBerry Administration Service, an HTTPS connection using port number 3443</td>
</tr>
</tbody>
</table>

---

## System requirements: BlackBerry Enterprise Server Express databases

<table>
<thead>
<tr>
<th><strong>Item</strong></th>
<th><strong>Requirement</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>database management system</td>
<td>Any of the following database management systems:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2005 SP3 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2005 SP4 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2005 Express SP3</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 SP3 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 R2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td>Item</td>
<td>Requirement</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Item</strong></td>
<td><strong>Requirement</strong></td>
</tr>
<tr>
<td>collation setting</td>
<td>To configure collation settings, the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• database server collation configured to default case-insensitive</td>
</tr>
<tr>
<td></td>
<td>• BlackBerry Configuration Database collation configured to default case-</td>
</tr>
<tr>
<td></td>
<td>insensitive</td>
</tr>
<tr>
<td></td>
<td>• collation must be the same for the Microsoft SQL Server instance and the</td>
</tr>
<tr>
<td></td>
<td>database server that hosts the BlackBerry database notification system</td>
</tr>
<tr>
<td></td>
<td>(BlackBerry Configuration Database)</td>
</tr>
<tr>
<td></td>
<td>• default collations are suggested though non-default collations are</td>
</tr>
<tr>
<td></td>
<td>supported (for more information, visit <a href="http://www.blackberry.com/go/kbhelp">www.blackberry.com/go/kbhelp</a></td>
</tr>
<tr>
<td></td>
<td>to read articles KB04785 and KB15534)</td>
</tr>
<tr>
<td>database connectivity</td>
<td>• TCP/IP network protocols turned on</td>
</tr>
<tr>
<td></td>
<td>• No count option turned off</td>
</tr>
<tr>
<td>nested triggers</td>
<td>Nested trigger support turned on. For more information, visit</td>
</tr>
<tr>
<td></td>
<td>msdn.microsoft.com to read article ms178101.</td>
</tr>
<tr>
<td>database transactional</td>
<td>To support database transactional replication for the BlackBerry</td>
</tr>
<tr>
<td>replication</td>
<td>Configuration Database, the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• the database server must be Microsoft SQL Server 2005 SP3 or later</td>
</tr>
<tr>
<td></td>
<td>• the database server that hosts the replicated database must use the same</td>
</tr>
<tr>
<td></td>
<td>version and build as the database server that hosts the primary</td>
</tr>
<tr>
<td></td>
<td>database</td>
</tr>
</tbody>
</table>
# System requirements: BlackBerry Attachment Service

The following system requirements apply to the computer that you install the BlackBerry Attachment Service on.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2 SP1</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2003</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2008</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2011 Standard</td>
</tr>
<tr>
<td>media player</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• if using Windows Server 2008, to support audio attachments, Windows Media Format SDK (for more information, visit msdn.microsoft.com and search Windows Media Format SDK)</td>
</tr>
<tr>
<td></td>
<td>• if using Windows Server 2003, to support audio attachments, Windows Media Player 9 or later</td>
</tr>
<tr>
<td>browser</td>
<td>Windows Internet Explorer 7.0 to 8.0 with language preferences configured to display encoded web pages</td>
</tr>
</tbody>
</table>
# System requirements: BlackBerry MDS Connection Service

The following system requirements apply to the computer that you install the BlackBerry MDS Connection Service on.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2 SP1</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2003</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2008</td>
</tr>
<tr>
<td></td>
<td>• Windows Small Business Server 2011 Standard</td>
</tr>
<tr>
<td>RSA Authentication Agent</td>
<td>To support enhanced network authentication (optional), RSA Authentication</td>
</tr>
<tr>
<td></td>
<td>Agent 6.1 for Windows Server 2003 or RSA Authentication Agent 7.0.1 for</td>
</tr>
<tr>
<td>memory</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• if you install a central push server and less than 1000 user accounts, a</td>
</tr>
<tr>
<td></td>
<td>minimum of 1024 MB</td>
</tr>
<tr>
<td></td>
<td>• if you install a central push server and more than 1000 user accounts, a</td>
</tr>
<tr>
<td></td>
<td>minimum of 3 GB</td>
</tr>
<tr>
<td></td>
<td>• if you do not install a central push server, a minimum of 512 MB</td>
</tr>
</tbody>
</table>
System requirements: BlackBerry Router

To install the BlackBerry Router on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server Express, any of the following operating systems:

- Windows Server 2003 SP2 (32-bit or 64-bit)
- Windows Server 2003 R2 SP2 (32-bit or 64-bit)
- Windows Server 2008 SP2 (32-bit or 64-bit)
- Windows Server 2008 R2
- Windows Server 2008 R2 SP1
- Windows Small Business Server 2003
- Windows Small Business Server 2008
- Windows Small Business Server 2011 Standard

System requirements for your organization's environment

The following system requirements apply when you configure single sign-on authentication for the BlackBerry Administration Service and BlackBerry Web Desktop Manager or configure the BlackBerry MDS Connection Service to support Integrated Windows authentication.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>network services</td>
<td>Microsoft Active Directory running at Windows Server 2003 domain functional level or higher</td>
</tr>
<tr>
<td>application server</td>
<td>For the BlackBerry MDS Connection Service to support Integrated Windows authentication, Microsoft IIS 6.0 or 7.0 using Integrated Windows authentication</td>
</tr>
<tr>
<td>file server</td>
<td>For the BlackBerry MDS Connection Service to support Integrated Windows authentication, Windows Server 2003 file services or Windows Server 2008 file services</td>
</tr>
</tbody>
</table>
## System requirements: Computers for BlackBerry Web Desktop Manager and BlackBerry Administration Service users

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>browser</td>
<td>• Windows Internet Explorer 7.0 to 8.0</td>
</tr>
<tr>
<td></td>
<td>• Mozilla Firefox 3.6</td>
</tr>
<tr>
<td></td>
<td>• Safari 4 for Mac</td>
</tr>
<tr>
<td></td>
<td>• Google Chrome 4</td>
</tr>
</tbody>
</table>

Windows Internet Explorer 7 or later provides optimal support for BlackBerry Web Desktop Manager features and BlackBerry Administration Service features. Depending on the browser that you use, the BlackBerry Web Desktop Manager and BlackBerry Administration Service might not recognize BlackBerry devices and the browser might prevent you from activating devices that are connected to the computer, backing up and restoring device data, or adding or updating device applications.

### browser settings for Windows Internet Explorer

To support browser access, you must configure the following settings:

- language preferences configured to display encoded web pages
- Microsoft hotfix 955839 installed on the users' computers to make sure the correct time zones are displayed
- the following settings turned on to support Microsoft ActiveX:
  - Automatic prompting for Microsoft ActiveX controls
  - Download signed Microsoft ActiveX controls
  - Run Microsoft ActiveX controls and plug-ins
  - Script Microsoft ActiveX controls marked safe for scripting
- support for JavaScript
- cookies turned on
## System requirements

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• support for TLS or SSL</td>
</tr>
<tr>
<td></td>
<td>• the SSL certificate installed to permit trusted connections to the BlackBerry Administration Service</td>
</tr>
<tr>
<td></td>
<td>• if using Windows Vista, the BlackBerry Administration Service web address added as a trusted web site and Enable protected mode cleared</td>
</tr>
<tr>
<td></td>
<td>• if you configure single sign-on authentication for the BlackBerry Administration Service</td>
</tr>
<tr>
<td></td>
<td>• the BlackBerry Web Desktop Manager and BlackBerry Administration Service web sites assigned to the local intranet zone</td>
</tr>
<tr>
<td></td>
<td>• Enable Integrated Windows Authentication selected</td>
</tr>
<tr>
<td></td>
<td>• if you do not configure single sign-on authentication for the BlackBerry Administration Service</td>
</tr>
<tr>
<td></td>
<td>• the BlackBerry Web Desktop Manager and BlackBerry Administration Service web sites assigned to the local intranet or trusted sites security zone</td>
</tr>
</tbody>
</table>

### browser settings for Firefox, Safari, and Google Chrome

To support browser access, you must configure the following settings:

• support for JavaScript
• cookies turned on
• support for TLS or SSL
• to permit trusted connections to the BlackBerry Administration Service, the SSL certificate installed

Single sign-on authentication for the BlackBerry Administration Service is not supported by Google Chrome.

### System requirements: Messaging server

Any of the following messaging servers that are located in close proximity to where you want to install the BlackBerry Enterprise Server Express:

• Microsoft Exchange Server 2010 SP1
• Microsoft Exchange Server 2010 and Microsoft Exchange Server 2010 Update Rollup 1 (Microsoft Exchange Server MAPI Client and CDO 1.2.1 must be version 6.5.8211.0 or later to support Microsoft Exchange Server 2010)
• Microsoft Exchange Server 2007 SP2 or SP3
• Microsoft Exchange Server 2003 SP2
• Any of the following Microsoft Exchange mixed environments:
  • Microsoft Exchange Server 2003 and 2007
  • Microsoft Exchange Server 2007 SP2 and 2010
  • Microsoft Exchange Server 2007 SP2 and 2010 SP1
  • Microsoft Exchange Server 2007 SP3 and 2010
  • Microsoft Exchange Server 2007 SP3 and 2010 SP1

To see the current compatibility matrix for the BlackBerry Enterprise Server Express, visit www.blackberry.com/go/compatibility.

System requirements: Firewall

To install the BlackBerry Enterprise Server Express, configure a firewall or proxy firewall with the following conditions:
• Exclusive use of port 3101 to open and maintain an outbound, bidirectional TCP/IP connection to an external server
• Support for resolving Internet addresses that use DNS
• For proxy firewalls, transparency of the proxy server

Supported features and environments

<table>
<thead>
<tr>
<th>Item</th>
<th>BlackBerry Enterprise Server Express</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messaging server</td>
<td>The BlackBerry Enterprise Server Express and BlackBerry Enterprise Server Express components support installation on the same computer as the messaging server.</td>
</tr>
<tr>
<td>Upgrades</td>
<td>You can upgrade any version of the BlackBerry Enterprise Server Express to a later version without having to uninstall the current version.</td>
</tr>
</tbody>
</table>
### BlackBerry Domain
Your organization’s BlackBerry Domain can contain more than one BlackBerry Enterprise Server Express instance. The different BlackBerry Enterprise Server Express instances in the BlackBerry Domain can be different versions, but the BlackBerry Configuration Database must be the same version as the latest BlackBerry Enterprise Server Express instance. The version of the BlackBerry Administration Service that you use to manage the BlackBerry Enterprise Server Express instances must be the same version as the BlackBerry Configuration Database.

For example, if your organization’s BlackBerry Domain contains a BlackBerry Enterprise Server Express 5.0 SP1 and a BlackBerry Enterprise Server Express 5.0 SP2, the BlackBerry Configuration Database must be version 5.0 SP2, and the BlackBerry Administration Service that you use to manage both BlackBerry Enterprise Server Express instances must be version 5.0 SP2.

### Virtual environment
For information, please visit [www.blackberry.com](http://www.blackberry.com) to read KB 29661.

### Enhanced network authentication

### IP
BlackBerry Enterprise Server Express components support only IPv4 for TCP/IP connections.

### SNMP monitoring
The BlackBerry Enterprise Server Express components support the SNMP service.

### Remote access
The BlackBerry Enterprise Server Express components support remote access by administrators who use Remote Desktop Connection.

### Unsupported environments

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMZ</td>
<td>The BlackBerry Enterprise Server Express and BlackBerry Enterprise Server Express components, with the exception of the BlackBerry Router, do not support installation in a DMZ.</td>
</tr>
<tr>
<td>messaging server</td>
<td>The BlackBerry Enterprise Server Express for Microsoft Exchange (and all BlackBerry Enterprise Server Express components) does not support installation on the computer that hosts the messaging server.</td>
</tr>
<tr>
<td>email application</td>
<td>The BlackBerry Enterprise Server Express and BlackBerry Enterprise Server Express components do not support installation on computers that host email applications such as Microsoft Outlook. Email applications use data files that</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BlackBerry Attachment Service</td>
<td>You must install the software update for KB22953 on Windows Server 2008 if you want the BlackBerry Attachment Service to support .mp3 audio files on BlackBerry devices and all audio formats on BlackBerry 7100 Series devices that support CDMA networks. To download the software update for KB22953, visit <a href="http://www.blackberry.com/support/downloads/">www.blackberry.com/support/downloads/</a>.</td>
</tr>
<tr>
<td>Remote Desktop Services or Terminal Services</td>
<td>The BlackBerry Enterprise Server Express and BlackBerry Enterprise Server Express components do not support installation on a computer that you installed Remote Desktop Services or Terminal Services on.</td>
</tr>
<tr>
<td>upgrades or migration</td>
<td>You cannot upgrade any version of the BlackBerry Enterprise Server, BlackBerry Professional Software, or BlackBerry Enterprise Server Small Business Edition to the BlackBerry Enterprise Server Express. You cannot migrate user accounts from the BlackBerry Enterprise Server, BlackBerry Professional Software, or BlackBerry Enterprise Server Small Business Edition to the BlackBerry Enterprise Server Express. For more information about the migration paths that the BlackBerry Enterprise Transporter supports for the BlackBerry Enterprise Server Express, visit <a href="http://www.blackberry.com/go/serverdocs">www.blackberry.com/go/serverdocs</a> to see the <em>BlackBerry Enterprise Transporter Installation and Configuration Guide</em>.</td>
</tr>
<tr>
<td>mixed environment</td>
<td>You cannot connect both a BlackBerry Enterprise Server and a BlackBerry Enterprise Server Express to the same BlackBerry Configuration Database. To run both a BlackBerry Enterprise Server and a BlackBerry Enterprise Server Express in the same organization, you can configure one BlackBerry Configuration Database for the BlackBerry Enterprise Server instances, and another BlackBerry Configuration Database for the BlackBerry Enterprise Server Express instances.</td>
</tr>
</tbody>
</table>
Preinstallation tasks

Configuring a Microsoft Exchange 2010 messaging environment

Create a Windows account that has a Microsoft Exchange 2010 mailbox

You must create a Windows account with a Microsoft Exchange 2010 mailbox so that the Windows account can authenticate with the Microsoft Exchange Server.

Before you begin: If you want free/busy lookups to work in Microsoft Outlook 2003 and earlier, you must configure Microsoft Exchange 2010 to support Microsoft Outlook 2003 and earlier by creating a public folder database. For more information about supporting Microsoft Outlook 2003 and earlier, visit http://support.microsoft.com to read article 555851 and visit http://technet.microsoft.com to read articles 123694, 124270, 397221, and 691120.

1. On the computer that hosts Microsoft Exchange, log in using an administrator account that has the permission to create accounts.
2. Open the Microsoft Exchange Management Console.
3. Create an account and mailbox that you name BESAdmin.
4. To permit the BlackBerry Enterprise Server Express to check if a BlackBerry device user has permission to access a public folder, assign the Owner permission for all public folders to the administrator account.

After you finish:
• To verify that you created the Windows account, log in to a computer using the Windows account.
• Verify that the Windows account is not a member of the Domain Administrators group in Microsoft Active Directory.
• Verify that BlackBerry device users have Read permissions and Visible permissions to public folders.
• To permit BlackBerry device users to check the availability of meeting participants using BlackBerry Device Software 4.5 or later, configure the Schedule+ Free/Busy information for the system public folder. For more information, visit http://technet.microsoft.com to read articles 629523 and 691129.

Related information
Manage the BlackBerry Enterprise Server Express performance in a Microsoft Exchange 2010 environment, 57

Configure Microsoft Exchange 2010 permissions for the Windows account

**Before you begin:**
Verify the domain name in Microsoft Active Directory. When you set the permissions, you must match the domain name in Microsoft Active Directory.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
3. Type `Add-RoleGroupMember "View-Only Organization Management" -Member "BESAdmin"`.
4. Type `Add-ADPermission -InheritedObjectType User -InheritanceType Descendents -ExtendedRights Send-As -User "BESAdmin" -Identity "DC=<domain_1>,DC=<domain_2>,DC=<domain_3>"` where `<domain_1>`, `<domain_2>`, and `<domain_3>` form the name of the domain.
   For example, if the domain name is example.organization.net, type `example` for `<domain_1>`, `organization` for `<domain_2>`, and `net` for `<domain_3>`.

**After you finish:** If you create a mailbox database for Microsoft Exchange, repeat step 2.

Turn off client throttling in Microsoft Exchange 2010

By default, Microsoft Exchange 2010 uses client throttling policies to track the bandwidth that each Microsoft Exchange user consumes and enforce bandwidth limits as necessary. The policies affect the performance of the BlackBerry Enterprise Server Express, so you should turn off client throttling for the Windows account that has a Microsoft Exchange mailbox.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. Type `New-ThrottlingPolicy BESPolicy`.
3. Type the following command: `Set-ThrottlingPolicy BESPolicy -RCAMaxConcurrency $null -RCAPercentTimeInAD $null -RCAPercentTimeInCAS $null -RCAPercentTimeInMailboxRPC $null -EWSMaxConcurrency $null -EWSPercentTimeInAD $null -EWSPercentTimeInCAS $null -EWSPercentTimeInMailboxRPC $null -EWSMaxSubscriptions $null -EWSFastSearchTimeoutInSeconds $null -EWSFindCountLimit $null`
4. Type `Set-Mailbox "BESAdmin" -ThrottlingPolicy BESPolicy`.
Increase the maximum number of connections to the Address Book service in Microsoft Exchange 2010

By default, Microsoft Exchange 2010 limits the maximum number of connections from the BlackBerry Enterprise Server Express to the Address Book service to 50. To permit the BlackBerry Enterprise Server Express to run, you must increase the number of permitted connections to a large value (for example, 100,000).

**Before you begin:** You must complete this task if the messaging server that the BlackBerry Enterprise Server Express uses is Microsoft Exchange 2010. If the messaging server is Microsoft Exchange 2010 SP1, you can change the MaxSessionsPerUser settings using client throttling policies.

1. On the computer that hosts the Microsoft Exchange CAS server, in `<drive>:\Program Files\Microsoft\Exchange Server \V14\Bin`, in a text editor, open the `microsoft.exchange.addressbook.service.exe.config` file.
2. Change the value of the MaxSessionsPerUser key to **100000**.
3. Save and close the file.
4. Restart the Address Book service.

Configure a management role for Microsoft Exchange Web Services

If you want the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services to manage calendars on BlackBerry devices, you must configure a management role for Microsoft Exchange Web Services in Microsoft Exchange 2010.

For more information about configuring the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services, see the *BlackBerry Enterprise Server Express Administration Guide*.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. Type `New-ManagementRoleAssignment -Name "BES Admin EWS" -Role ApplicationImpersonation -User "BESAdmin"`. 
Configure the BlackBerry Enterprise Server Express to run without public folders

If you did not install any public folders in Microsoft Exchange, you must configure the BlackBerry Enterprise Server Express to run without public folders by changing a registry key.

1. On each computer that hosts the BlackBerry Enterprise Server Express, click Start > Run.
2. In the Open field, type regedit.
3. Click OK.
4. Perform one of the following actions:
   - If you are running a 32-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft \Windows Messaging Subsystem\CDO.
   - If you are running a 64-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node \Microsoft\Windows Messaging Subsystem.
5. If the CDO registry key does not exist, create a registry key that you name CDO.
6. In the CDO registry key, if the DWORD value does not exist, create a DWORD value that you name Ignore No PF.
7. Change the DWORD value to 1.
8. Click OK.

Permit meeting requests from outside of your organization when using Microsoft Exchange Web Services for Microsoft Exchange 2010

By default, the BlackBerry Enterprise Server Express uses Microsoft Exchange Web Services to manage calendars on BlackBerry devices. Each time you add a new Microsoft Exchange mailbox, you must configure the calendar settings in Microsoft Exchange to permit BlackBerry device users to receive meeting requests from outside of your organization when using Microsoft Exchange Web Services.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. For each Microsoft Exchange Server that hosts users, type the following command:
   `Get-Mailbox -server<messaging-server name> | Set-CalendarProcessing -ProcessExternalMeetingMessages $true`
Configuring a Microsoft Exchange 2007 messaging environment

Create a Windows account that has a Microsoft Exchange 2007 mailbox

You must create a Windows account that has a Microsoft Exchange 2007 mailbox so that the Windows account can authenticate with the Microsoft Exchange Server.

Before you begin: You must configure Microsoft Exchange 2007 to support versions of Microsoft Outlook that are earlier than 2007 by creating a public folder database. For more information about supporting versions of Microsoft Outlook that are earlier than 2007, visit http://support.microsoft.com to read article 555851 and visit http://technet.microsoft.com to read articles 123694, 124270, 397221, and 691120.

1. On the computer that hosts Microsoft Exchange, log in using an administrator account that has the correct permission to create accounts.
2. Open the Microsoft Exchange Management Console.
3. Create an account and mailbox that you name BESAdmin.
4. To permit the BlackBerry Enterprise Server Express to check if a user has permissions for a public folder, assign the Owner permission for all public folders to the administrator account.

After you finish:
- To verify that you created the Windows account, log in to a computer using the Windows account.
- Verify that the Windows account is not a member of the Domain Administrators group in Microsoft Active Directory.
- Verify that BlackBerry device users have Read and Visible permissions to public folders.
- To permit BlackBerry device users to check the availability of meeting participants in BlackBerry Device Software 4.5 or later, configure the Schedule+ Free/Busy information for the system public folder. For more information, visit http://technet.microsoft.com to read articles 629523 and 691129.
Configure Microsoft Exchange 2007 permissions for the Windows account

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.

2. Perform one of the following actions:
   - If you log in to Microsoft Exchange Server 2007, type `add-exchangeadministrator "BESAdmin" -role ViewOnlyAdmin`.
   - If you log in to another computer, type `get-mailboxserver "<messaging_server_name>" | add-exchangeadministrator "BESAdmin" -role ViewOnlyAdmin`.

3. For each Microsoft Exchange Server 2007 instance that hosts BlackBerry device users, type the following command:
   `get-mailboxserver "<messaging_server_name>" | add-adpermission -user "BESAdmin" -accessrights ExtendedRight -extendedrights Receive-As, ms-Exch-Store-Admin`.

Permit users to send email messages in a Microsoft Exchange environment

To permit BlackBerry device users to send email messages, you must configure Send As permissions for the Microsoft Active Directory user object that contains users. This task describes how to configure the Send As permissions for the entire Windows domain, but you can also configure the permissions at the user object level or on a container of user objects.

For more information about Send As permissions and the BlackBerry Enterprise Server Express, visit www.blackberry.com/btsc to read article KB04707. For more information about assigning Send As permissions permissions to multiple user accounts, visit support.microsoft.com to read article 912918.

1. Log in to a computer in the Windows domain as an administrator that has permissions to change user objects in Microsoft Active Directory.


3. On the View menu, click Advanced Features.

4. Right-click the domain root. Click Properties.


6. Click Add.

7. Type the name of the Windows account that you created (for example, BESAdmin).
8. Click **Check Names**.

9. Click **OK**.

10. Perform one of the following actions:
    - If you are running Windows Server 2003, in the **Apply** drop-down list, click **User Objects**.
    - If you are running Windows Server 2008, in the **Apply** drop-down list, click **Descendant User Objects**.

11. In the **Allow** column, select the **Send As** check box.

12. Click **Apply**.

13. Click **OK**.

Permit meeting requests from outside of your organization when using Microsoft Exchange Web Services for Microsoft Exchange 2007

By default, the BlackBerry Enterprise Server Express uses Microsoft Exchange Web Services to manage calendars on BlackBerry devices. Each time you add a new Microsoft Exchange mailbox, you must configure the calendar settings in Microsoft Exchange to permit BlackBerry device users to receive meeting requests from outside of your organization when using Microsoft Exchange Web Services.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.

2. For each Microsoft Exchange Server that hosts users, type the following command:
   ```powershell
   Get-Mailbox -server <messaging-server name> | Set-MailboxCalendarSettings -ProcessExternalMeetingMessages $true
   ```
Configuring a Microsoft Exchange 2003 messaging environment

Create a Windows account that has a Microsoft Exchange 2003 mailbox

You must create a Windows account that has a Microsoft Exchange 2003 mailbox so that the Windows account can authenticate with the Microsoft Exchange messaging server.

1. On any computer in the Windows domain, on the taskbar, click Start > Programs > Microsoft Exchange > Active Directory Users and Computers.
2. Create an account that has the following attributes:
   - **Name:** BESAdmin
   - **Group membership:** Domain User
3. Create a Microsoft Exchange mailbox for the account.
4. To activate the new mailbox, send a test email message.

**After you finish:**

If you cannot see the Windows account in the Microsoft Active Directory to verify that you created it, log in to a computer using the Windows account.

For more information about the Send As permission and the BlackBerry Enterprise Server Express, visit [www.blackberry.com](http://www.blackberry.com) to read KB04707.

For more information about assigning the Send As permission to multiple user accounts, visit [www.support.microsoft.com](http://www.support.microsoft.com) to read article 912918.
Configure Microsoft Exchange 2003 permissions for the Windows account

On each Microsoft Exchange 2003 server that hosts BlackBerry device users, you must configure Microsoft Exchange permissions for the Windows account (for example, BESAdmin) that you want to use to install the BlackBerry Enterprise Server Express components.

This task describes how to configure the Microsoft Exchange permissions at the administrative group level for every Microsoft Exchange 2003 server that hosts BlackBerry device users but you can also configure the permissions at other levels, such as at the root of the organization or another administrative group.

1. On the computer that hosts the Microsoft Exchange 2003 System Manager, open the Microsoft Exchange 2003 System Manager.

2. Configure the Exchange View Only Administrator permission for the Windows account in the administrative group that contains the Microsoft Exchange 2003 servers that host BlackBerry device users.

3. On each Microsoft Exchange 2003 server that hosts BlackBerry device users, assign the following permissions to the Windows account:
   - Send As
   - Receive As
   - Administer Information Store

4. To permit the BlackBerry Enterprise Server Express to check if users have permissions to access a public folder, assign the Owner permission for all public folders to the Windows account.

   **After you finish:** Verify that the users have Read and Visible permissions to public folders.

Permit users to send email messages in a Microsoft Exchange environment

To permit BlackBerry device users to send email messages, you must configure Send As permissions for the Microsoft Active Directory user object that contains users. This task describes how to configure the Send As permissions for the entire Windows domain, but you can also configure the permissions at the user object level or on a container of user objects.

For more information about Send As permissions and the BlackBerry Enterprise Server Express, visit [www.blackberry.com/btsc](http://www.blackberry.com/btsc) to read article KB04707. For more information about assigning Send As permissions permissions to multiple user accounts, visit [support.microsoft.com](http://support.microsoft.com) to read article 912918.
1. Log in to a computer in the Windows domain as an administrator that has permissions to change user objects in Microsoft Active Directory.
2. On the taskbar, click **Start** > **Administrative Tools** > **Active Directory Users and Computers**.
3. On the **View** menu, click **Advanced Features**.
4. Right-click the domain root. Click **Properties**.
5. On the **Security** tab, click **Advanced**.
6. Click **Add**.
7. Type the name of the Windows account that you created (for example, BESAdmin).
8. Click **Check Names**.
9. Click **OK**.
10. Perform one of the following actions:
    - If you are running Windows Server 2003, in the **Apply** drop-down list, click **User Objects**.
    - If you are running Windows Server 2008, in the **Apply** drop-down list, click **Descendant User Objects**.
11. In the **Allow** column, select the **Send As** check box.
12. Click **Apply**.
13. Click **OK**.

### Configure permissions for the Windows account

On each computer that you want to install the BlackBerry Enterprise Server Express components on, you must configure permissions for the Windows account that you want to use to install the BlackBerry Enterprise Server Express components and run the services for the BlackBerry Enterprise Server Express.

Without the correct permissions, the BlackBerry Enterprise Server Express cannot run.

1. Right-click **My Computer**. Click **Manage**.
2. In the left pane, expand **Local Users and Groups**.
3. Navigate to the **Groups** folder.
4. In the right pane, double-click **Administrators**.
5. Click **Add**.
6. In the **Enter the object names to select** field, type the Windows account name that you want the services for the BlackBerry Enterprise Server Express to use (for example, BESAdmin).

7. Click **OK**.

8. Click **Apply**.

9. Click **OK**.

10. On the taskbar, click **Start > Programs > Administrative Tools > Local Security Policy**.

11. Configure the following permissions for the Windows account:
   - log on locally with local permissions (if not assigned by default)
   - log on as a service

12. On the taskbar, click **Start > Programs > Administrative Tools > Computer Management**.

13. Add the Windows account to the local administrators group.

---

**Prevent the Microsoft Exchange known issues for wireless calendar synchronization**

Some known issues for Microsoft Exchange impact how the BlackBerry Enterprise Server Express synchronizes calendars over the wireless network. To prevent the known issues from occurring, you can read about the known issues for Microsoft Exchange that might impact your organization’s messaging environment and install the hotfixes for them. If your organization’s messaging environment includes multiple messaging servers, you can resolve the known issues that apply to the latest Microsoft Exchange software version in your organization’s environment.

If you do not install the correct hotfixes, the BlackBerry Enterprise Server Express cannot run.

1. Visit [http://support.microsoft.com](http://support.microsoft.com) to read articles 823343 and 894470.

2. Verify that your organization’s environment meets the requirements that are described in the applicable known issues.

3. Download the hotfixes for the known issues on the computers that you want to install the BlackBerry Enterprise Server Express or BlackBerry Administration Service on.

4. Install the hotfixes.
Verify if the Windows account can access a user account in Microsoft Exchange

The BlackBerry Enterprise Server Express requires permission to access each BlackBerry device user’s mailbox to process email messages. The IEMSTest.exe tool runs a test to verify whether the Windows account has the Send As permission in Microsoft Exchange so that the BlackBerry Enterprise Server Express can access user accounts. The IEMSTest.exe tool does not verify whether the BlackBerry Enterprise Server Express can send email messages on behalf of a BlackBerry device user.

1. Copy the BlackBerry Enterprise Server Express installation files to the computer that you want to install the BlackBerry Enterprise Server Express on.
2. Extract the contents to a folder on the computer.
3. Navigate to <extracted_folder>\Tools.
4. Double-click IEMSTest.exe.
5. In the Profile Name drop-down list, select the profile names for the user accounts.
6. Click OK.
7. In the left pane, select the user accounts that you want to check.
8. Click Select.
9. Click OK.

Configuring connections for the BlackBerry Enterprise Server Express database

The database for the BlackBerry Enterprise Server Express is the BlackBerry Configuration Database. You create the BlackBerry Configuration Database when you install a BlackBerry Enterprise Server Express or BlackBerry Administration Service or when you run the CreateDB executable.

The BlackBerry Enterprise Server Express can connect to its database on the Microsoft SQL Server using Windows authentication or database authentication. By default, the BlackBerry Enterprise Server Express logs in to its database using the Windows account that you use to complete the installation process or the database credentials you provided during the installation process.
Specifying permissions when you connect to the BlackBerry Configuration Database using Windows authentication or Microsoft SQL Server authentication

If you connect the BlackBerry Enterprise Server Express to the BlackBerry Configuration Database using Windows authentication or Microsoft SQL Server authentication during the installation process, the Windows account or Microsoft SQL Server account that you specify must have database permissions on the database server. The type of permissions that you specify is determined by the setup option that you select and whether you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server Express components or on another database server.

Specifying permissions for the Windows account or Microsoft SQL Server account

If you install Microsoft SQL Server 2008 R2 Express Edition during the BlackBerry Enterprise Server Express installation process, you might need to specify permissions for the Windows account or Microsoft SQL Server account, depending on the type of authentication you select.

When you select Windows authentication during the BlackBerry Enterprise Server Express installation process, the setup application automatically assigns the required permissions to the Windows account that you use to complete the installation process.

When you select Microsoft SQL Server authentication during the BlackBerry Enterprise Server Express installation process, you must assign the required database permissions to the Microsoft SQL Server account that you use to complete the installation process.

Assign permissions to the Windows account or Microsoft SQL Server account

Perform one of the following actions:

- If you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server Express and you require the setup application to install Microsoft SQL Server Express during the installation process and you choose Windows authentication, you are not required to assign Microsoft SQL Server permissions to the Windows account. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account.

- If you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server Express and you require the setup application to install Microsoft SQL Server Express during the installation process and you choose Microsoft SQL Server authentication, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Microsoft SQL Server account. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system...
administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Microsoft SQL Server account.

- If you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server Express and the computer already hosts a Microsoft SQL Server, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Windows account or Microsoft SQL Server account that you use to complete the BlackBerry Enterprise Server Express installation process. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account or Microsoft SQL Server account.

- If you create the BlackBerry Configuration Database on a computer that does not host the BlackBerry Enterprise Server Express, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Windows or Microsoft SQL Server account that you use to complete the BlackBerry Enterprise Server Express installation process. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account or Microsoft SQL Server account.

Create a BlackBerry Configuration Database

If the security required by your organization does not allow applications to have permissions to create or upgrade databases, you can run the CreateDB executable on the database server to create the BlackBerry Configuration Database instead of using the setup application. After you create or upgrade the BlackBerry Configuration Database using the CreateDB executable, you can run the setup application using a Windows account with minimum requirements to the database server.

**Before you begin:** Verify that the appropriate permissions are configured on the database server.

1. Log in to the computer that hosts the database server using a local administrator account or a Windows account that has SQL administrator permissions.
2. Copy the BlackBerry Enterprise Server Express installation files to the database server that you want to configure as the host server for the BlackBerry Configuration Database.
3. Extract the contents to a folder on the computer.
4. Navigate to `<extracted_folder>\Database`.
5. Open the `BesMgmt.cfg` file in a text editor.
6. Change the file to include information that is specific to your organization’s environment.
7. Save and close the file.
8. Open a command prompt window.
9. Change to `<extracted_folder>\Database`.
10. Type `CreateDB.exe BESMgmt.cfg`. 

Installation and Configuration Guide

Preinstallation tasks
## BESMgmt.cfg properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD</td>
<td>This property specifies the type of action that the CreateDB executable must complete (for example, whether to install or upgrade the BlackBerry Configuration Database).</td>
</tr>
<tr>
<td>DATABASE_NAME</td>
<td>This property specifies the name of the BlackBerry Configuration Database.</td>
</tr>
<tr>
<td>SERVER</td>
<td>This property specifies the name of the database server that hosts the BlackBerry Configuration Database. If a database instance hosts the BlackBerry Configuration Database, follow the format <code>database_server_name\database_instance_name</code>.</td>
</tr>
<tr>
<td>USERID</td>
<td>If you use database authentication, this property specifies the user name of the database account that has server administrator permission and database creator permission.</td>
</tr>
<tr>
<td>PASSWORD</td>
<td>If you use database authentication, this property specifies the password for the database account.</td>
</tr>
<tr>
<td>SCRIPT_ROOT</td>
<td>This property specifies the path to the DBInstallScripts folder. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>LOG_DIR</td>
<td>This property specifies the path to the folder that you want to create log files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>DBMS</td>
<td>This property specifies the database management system that your organization uses.</td>
</tr>
<tr>
<td>DB_FILE_DIR</td>
<td>This property specifies an existing folder that you want to save the database files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>BACKUP_DIR</td>
<td>This property specifies an existing folder where you want to save the database backup in. By default, this folder is located in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>BES_TYPE</td>
<td>This property specifies the messaging server that your organization uses.</td>
</tr>
</tbody>
</table>
Applications that are installed with the BlackBerry Enterprise Server Express components

You can use the BlackBerry Enterprise Server Express installation process to install third-party applications.

<table>
<thead>
<tr>
<th>Application</th>
<th>BlackBerry Enterprise Server Express components that the application is installed with</th>
</tr>
</thead>
<tbody>
<tr>
<td>JDK with JRE 1.6.31</td>
<td>• BlackBerry Administration Service</td>
</tr>
</tbody>
</table>
| JDK 1.6.31 | • BlackBerry Administration Service  
 • BlackBerry MDS Connection Service |
| Microsoft XML Core Services 6.0 SP2 | • All components except the BlackBerry Router |
| Microsoft SQL Server 2008 R2 Express Edition (if selected) | • BlackBerry Administration Service  
 • Any other components |
| Microsoft .NET Framework 2.0 (if you are installing Microsoft SQL Server Express) | • All components |
Installing the BlackBerry Enterprise Server Express software

Prerequisites: Installing the BlackBerry Enterprise Server Express software

- Verify that the Windows account that you use to install the BlackBerry Enterprise Server Express software is assigned the local administrator permission on the computer that you perform the installation process on.
- Verify that the Windows account that you want to use to install the BlackBerry Enterprise Server Express software is not a member of the Domain Admins group in Microsoft Active Directory.
- In a Microsoft Exchange 2003 environment, to start the MAPI subsystem, open the Microsoft Exchange System Manager.
- In a Windows Server 2003 environment, to install Microsoft SQL Server 2008 R2 Express Edition during the installation of BlackBerry Enterprise Server Express, you must install Windows PowerShell 1.0, Microsoft .NET Framework 3.5 SP1, and Microsoft Windows Installer 4.5 before you run the BlackBerry Enterprise Server Express setup application.
- If your organization’s domain controllers are running on Windows Server 2008, verify that the number of NSPI connections that the BlackBerry Enterprise Server Express can make to the Microsoft Exchange Server meets the requirements of your organization. For more information, visit www.blackberry.com/btsc to read article KB17325 and visit support.microsoft.com to read article 949469.
- Retrieve the following information:
  - BlackBerry CAL key
  - SRP host
  - SRP identifier
  - SRP authentication key
  - computer name and port number of the proxy server (if applicable)
• Add the blackberry.net domain to the permitted lists in the antivirus application or anti-spam application that the messaging server or gateway uses.

• Verify that the computer has access to www.blackberry.com (optional).

• If your organization uses a proxy server for Internet access, get the credentials for the proxy server.

• Verify that you installed the appropriate languages and text services on the computer that you use to install the BlackBerry Enterprise Server Express, including code page 20127 (US-ASCII) which is required for all supported languages.

• If you want to install Microsoft SQL Server 2008 R2 Express Edition on a computer that does not host any BlackBerry Enterprise Server Express components, you can navigate to the Tools folder in the BlackBerry Enterprise Server Express installation files and run Sqlexpr.exe.

• If you are installing the BlackBerry Administration Service, verify that the computers that host the BlackBerry Administration Service and BlackBerry Configuration Database are not separated by a WAN bridge.

• If you are performing the installation on a computer that has more than one NIC, verify that the production NIC is first in the bind order in the Windows network settings.

Install the BlackBerry Enterprise Server Express software

**Note:** To administer the BlackBerry Enterprise Server Express, you must install the BlackBerry Administration Service. You can install the BlackBerry Administration Service on the computer that hosts the BlackBerry Enterprise Server Express or on a separate computer. If you create a BlackBerry Configuration Database you must also install the BlackBerry Administration Service. The first time that you run the setup application in your organization's BlackBerry Domain or install or upgrade the BlackBerry Administration Service and the BlackBerry Configuration Database, you must run the setup application again if you want to install additional BlackBerry Enterprise Server Express components or remote components.

1. Log in to the computer that you want to install the BlackBerry Enterprise Server Express on using the Windows account that you created and that has correct permissions. This account runs the BlackBerry Enterprise Server Express services.

2. In the BlackBerry Enterprise Server Express installation files, double-click **setup.exe**. If the operating system in your organization’s environment is Windows Server 2008 or later or Windows Small Business Server 2008 or later, run **setup.exe** as an administrator.

3. Accept the BlackBerry Enterprise Server Express license agreement. Click **Next**.

4. In the **Setup type** dialog box, perform one of the following actions:

   • If you are installing a new BlackBerry Enterprise Server Express, select **Create a BlackBerry Configuration Database**.
• If you are installing an additional BlackBerry Enterprise Server Express instance and you want to associate it with an existing BlackBerry Configuration Database, click **Use an existing BlackBerry Configuration Database**.

5. Click **Next**.

6. In the **Setup options** dialog box, specify whether you want the setup application to install all the BlackBerry Enterprise Server Express components on the computer that you logged into or some of the BlackBerry Enterprise Server Express components on a different computer. Click **Next**.

7. In the **Preinstallation checklist** dialog box, perform one of the following actions:
   - To continue, click **Next**.
   - To complete requirements that were identified in the checklist, click **Cancel**. You can restart the installation or upgrade at a later time.

8. In the **Database options** dialog box, perform one of the following actions:
   - If you want to install the BlackBerry Configuration Database on the computer that you are running the setup application on, and you want to install a local database for the BlackBerry Configuration Database, select **Install Microsoft SQL Server 2008 R2 Express Edition on this computer**.
   - If you want install the BlackBerry Configuration Database on an existing database (local or remote), select **Use a Microsoft SQL Server database**.

9. Click **Next**.

10. In the **Accounts and Folders** dialog box, in the **Windows account information** section, in the **Password** field, type the password for the Windows account that you are using to install the BlackBerry Enterprise Server Express.

11. In the **BlackBerry Enterprise Server** section, in the **Name** field, type the name of the BlackBerry Enterprise Server Express that you want the BlackBerry Administration Service to display. Click **Next**.

12. In the **Summary** dialog box, verify the setup information.

13. Click **Install** to start the installation process.

14. After the setup application installs the necessary components, click **Continue**.

15. In the **Database information** dialog box, in the **Database location** section, perform one of the following actions:
   - If you want to install the BlackBerry Configuration Database on a local Microsoft SQL Server on the computer, select **Local**.
   - If you want to install the BlackBerry Configuration Database on a Microsoft SQL Server on a remote computer, select **Remote**.

16. If necessary, in the **Microsoft SQL Server name** field, type the name or IP address for the computer that hosts the Microsoft SQL Server.

17. In the **BlackBerry Configuration Database name** field, type a name for the BlackBerry Configuration Database.
18. Specify the port configuration (the static configuration was the option that was originally specified using the database server). If the configuration is static, in the Port field, specify the port number that the BlackBerry Enterprise Server Express can use to connect to the BlackBerry Configuration Database.

19. In the **Database authentication** section, perform one of the following actions:
   - If you want the BlackBerry Enterprise Server Express to connect to the BlackBerry Configuration Database on the Microsoft SQL Server using Windows authentication, select **Windows authentication**.
   - If you want the BlackBerry Enterprise Server Express to connect to the BlackBerry Configuration Database on the Microsoft SQL Server using database authentication, select **SQL authentication**. In the SQL user name and Password fields, type the required login information.

20. Click **Next**.

21. When you receive a prompt to create the BlackBerry Configuration Database, click **Yes**. The setup application notifies you when the database is created.

22. In the **BlackBerry CAL and SRP information** dialog box, type the BlackBerry Client Access License key, SRP host, and SRP authentication information that you received with your installation package.

23. In the SRP host and SRP authentication information sections, click **Verify** to verify that the information is correct. Click **Next**.

24. If necessary, in the **Administration settings** dialog box, in the Port settings section, change the default port information.

25. In the **Password for the SSL certificate** section, type and confirm a password for the SSL certificate that the setup application creates to establish communication between the BlackBerry Administration Service and the web browsers that you use to access the BlackBerry Administration Service. Click **Next**.

26. In the **Microsoft® Active Directory® settings** dialog box, in the User password field, type the password for the Microsoft Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server Express uses to authenticate with Microsoft Active Directory. If you want to specify a different username and Windows domain, you must make sure that the Windows domain belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.

27. In the **Advanced administration settings** dialog box, select the type of authentication that you want to use to log in to the BlackBerry Administration Service:
   - If you select **Use Windows authentication**, you can select whether you want to use the credentials of the current account that you are using to install the BlackBerry Enterprise Server Express, or you can specify account information for a Microsoft Active Directory administrator.
   - If you select **Use BlackBerry Administration Service authentication**, type the login information that you want to use to log in to the BlackBerry Administration Service.

28. Click **Next**.

29. In the **Start services** dialog box, click **Start Services**. When all of the BlackBerry Enterprise Server Express services start, click **Next**.
30. In the **Console addresses** dialog box, click **Finish**. By default, the setup application writes the BlackBerry Administration Service and the BlackBerry Web Desktop Manager web addresses to a .txt file.

**After you finish:**
- Verify that the collation setting for the BlackBerry Configuration Database is default case-insensitive.
- If you reinstalled the BlackBerry Administration Service, in Windows Internet Explorer, delete the cache.
- The size of log files for the BlackBerry Enterprise Server Express components varies based on the number of users in your BlackBerry Enterprise Server Express environment and the level of user activity. It is a best practice to monitor and control the amount of disk space that is taken up by the BlackBerry Enterprise Server Express log files. For more information about configuring logging, visit [www.blackberry.com/go/serverdocs](http://www.blackberry.com/go/serverdocs) to see the *BlackBerry Enterprise Server Express Administration Guide*.

---

**Install a BlackBerry Enterprise Server Express component on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server Express**

**Before you begin:**
- Install a BlackBerry Enterprise Server Express and the BlackBerry Administration Service in your organization’s environment.
- Verify that the BlackBerry Administration Service is running on a Windows account that has permission to access and change the Windows registry on the computer that you want to install the BlackBerry Enterprise Server Express component on.

1. Use the Windows account that you created to log in to the computer that is separate from the computer that hosts the BlackBerry Enterprise Server Express. The Windows account runs the services for the BlackBerry Enterprise Server Express components.
2. In the BlackBerry Enterprise Server Express installation files, double-click **setup.exe**. If the operating system in your organization’s environment is Windows Server 2008 or later or Windows Small Business Server 2008 or later, run **setup.exe** as an administrator.
3. Accept the BlackBerry Enterprise Server Express license agreement. Click **Next**.
4. In the **Setup type** dialog box, select **Use an existing BlackBerry Configuration Database**. Click **Next**.
5. In the **Database information** dialog box, specify the information for the BlackBerry Configuration Database for the BlackBerry Enterprise Server Express that you want to associate the remote component with. Click **Next**.
6. In the **Setup options** dialog box, in the **Options** section, select **Remote component**.

7. In the **Components** section, select the BlackBerry Enterprise Server Express components that you want to install. The setup application upgrades any components that you previously installed that you select. The components might be unavailable for BlackBerry device users during the installation process.

   If you installed a BlackBerry Enterprise Server Express component on the computer previously, the component is selected. If you clear the check mark for the component, the setup application removes the component from the computer.

8. Click **Next**.

9. In the **Preinstallation checklist** dialog box, perform one of the following actions:
   - To continue, click **Next**.
   - To complete requirements that were identified in the checklist, click **Cancel**. You can restart the installation or upgrade at a later time.

10. In the **Accounts and Folders** dialog box, in the **Windows account information** section, in the **Password** field, type the password for the Windows account that you are using to install the component.

11. In the **Summary** dialog box, verify the setup information.

12. Click **Install** to start the installation process.

13. Perform one of the following actions:
   - If the setup application prompts you to restart the computer, click **Yes**. After the computer restarts, log in to the computer using the same account that you used in step 1.
   - If the setup application does not prompt you to restart the computer, after the setup application installs the necessary components, click **Continue**.

14. If necessary, in the **BlackBerry CAL and SRP information** dialog box, verify that the information is correct. If you change any information, click **Verify** to verify that the information that you changed is correct. Click **Next**.

15. If necessary, in the **Administration settings** dialog box, verify the settings.

16. If necessary, in the **Password for the SSL certificate** section, type and confirm a password for the SSL certificate that the setup application creates to establish communication between the BlackBerry Administration Service and the web browsers that you use to access the BlackBerry Administration Service. Click **Next**.

17. In the **Microsoft® Active Directory® settings** dialog box, in the **User password** field, type the password for the Microsoft Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server Express uses to authenticate to Microsoft Active Directory. If you want to specify a different user name and user domain, you must make sure that the user domain belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.

18. Click **Next**. If the setup application cannot locate any of the global catalog servers that are associated with the Microsoft Active Directory account after you click the **Next** button, you must choose the global catalog servers that you want to add to the list manually. To add a global catalog server to the list, click the **Add** button and select the appropriate server. Each global catalog server that you add to the list must belong to the same domain as the Microsoft Active Directory user account.
19. In the **Start services** dialog box, click **Start Services**. When all of the BlackBerry Enterprise Server Express services start, click **Next**.

20. In the **Console addresses** dialog box, click **Finish**. By default, the setup application writes the BlackBerry Administration Service and the BlackBerry Web Desktop Manager web addresses to a .txt file.

**After you finish:**
- To view the component in the BlackBerry Administration Service, restart the BlackBerry Administration Service.
- If you reinstalled the BlackBerry Administration Service, in Windows Internet Explorer, delete the cache.
- If necessary, configure the BlackBerry Enterprise Server Express to connect with the remote component.
- The size of log files for the BlackBerry Enterprise Server Express components varies based on the number of users in your BlackBerry Enterprise Server Express environment and the level of user activity. It is a best practice to monitor and control the amount of disk space taken up by the BlackBerry Enterprise Server Express log files. For more information about configuring logging, visit [www.blackberry.com/go/serverdocs](http://www.blackberry.com/go/serverdocs) to see the *BlackBerry Enterprise Server Express Administration Guide*.

**Related information**
- Configuring communication with distributed components, 59

---

**Install a standalone BlackBerry Router**

A standalone BlackBerry Router is a BlackBerry Router that is hosted by a computer that does not host any other BlackBerry Enterprise Server Express components except the BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Router and restarts the BlackBerry Router if it stops responding.

**Note:** You cannot manage the BlackBerry Controller that monitors a standalone BlackBerry Router in the BlackBerry Administration Service. You must manage the BlackBerry Controller in the BlackBerry Configuration Panel on the computer that hosts the standalone BlackBerry Router.

1. Log in to the computer using the Windows account that you want to use to run the BlackBerry Router.
2. In the BlackBerry Enterprise Server Express installation files, double-click **setup.exe**. If the operating system in your organization's environment is Windows Server 2008 or later or Windows Small Business Server 2008 or later, run **setup.exe** as an administrator.
3. Accept the BlackBerry Enterprise Server Express license agreement. Click **Next**.
4. In the **Setup type** dialog box, select **Install a standalone BlackBerry Router**. Click **Next**.
5. In the **Setup options** dialog box, accept the default selection. Click **Next**.
6. In the **Preinstallation checklist** dialog box, perform one of the following actions:
   - To continue, click **Next**.
To complete requirements that were identified in the checklist, click **Cancel**. You can restart the installation or upgrade at a later time.

7. In the **Accounts and Folders** dialog box, in the **Windows account information** section, in the **Password** field, type the password of the Windows account that you are using to install the BlackBerry Router.

8. In the **Summary** dialog box, verify the setup information.

9. Click **Install** to start the installation process.

10. After the setup application installs the required components, click **Continue**.

11. In the **BlackBerry CAL and SRP information** dialog box, verify that the information is correct. If you change any information, click **Verify** to verify that the information that you changed is correct.

12. In the **Start services** dialog box, click **Start Services**. When all of the BlackBerry Enterprise Server Express services start, click **Next**.

13. In the **Console addresses** dialog box, click **Finish**. By default, the setup application writes the BlackBerry Administration Service and the BlackBerry Web Desktop Manager web addresses to a .txt file

**After you finish:**

- Associate the standalone BlackBerry Router with a BlackBerry Enterprise Server Express.
- The size of log files for the BlackBerry Enterprise Server Express components varies based on the number of users in your BlackBerry Enterprise Server Express environment and the level of user activity. It is a best practice to monitor and control the amount of disk space taken up by the BlackBerry Enterprise Server Express log files. For more information about configuring logging, visit [www.blackberry.com/go/serverdocs](http://www.blackberry.com/go/serverdocs) to see the *BlackBerry Enterprise Server Express Administration Guide*.

**Related information**

- **Connecting to a BlackBerry Router**, 61

---

**Test the connection from the BlackBerry Router to the BlackBerry Infrastructure**

To make sure that the BlackBerry Router can connect to the BlackBerry Infrastructure, you can test the connection using the BBSRPTest tool that is included with the BlackBerry Enterprise Server Express installation files. The BBSRPTest tool tries to connect to the BlackBerry Infrastructure using the SRP address and SRP port that you specified for the BlackBerry Infrastructure during the BlackBerry Router installation process.

1. On the computer that you want to test the connection to the BlackBerry Infrastructure on, at a command prompt, navigate to `<drive>\Program Files\Research In Motion\BlackBerry Enterprise Server`.

2. Type `bbsrptest <srp_address> -<port>` , where `<srp_address>` is the SRP address that you provided during the installation process and `<port>` is the SRP port number. For example, at the command line, type `bbsrptest.exe –host server1.example.com –port 3101`. 

---

48
After you finish: If the test does not complete, use the Windows Socket (WINSOCK) error code to diagnose the problem. For more information, visit http://msdn.microsoft.com to read article *Windows Socket Error Codes.*
Postinstallation tasks

Test the BlackBerry Enterprise Server Express installation

1. In the Windows Services, verify that the services for the BlackBerry Enterprise Server Express are running.
2. In the Windows Event Viewer and log files that are located in `<drive>:\Program Files\Research In Motion\BlackBerry Enterprise Server\Logs`, check for error messages.
3. In the BlackBerry Administration Service, add a test user account. If you can add a test user account, the connection from the BlackBerry Enterprise Server Express to the BlackBerry Configuration Database and the messaging server is open.
4. If you installed the BlackBerry MDS Connection Service, browse to `http://<BES_host>:8080`. If the status page appears, the BlackBerry MDS Connection Service is running.

After you finish: For troubleshooting information, visit www.blackberry.com/support.

Install the BlackBerry database notification system

The BlackBerry database notification system is a publish/subscribe system that is designed to reduce the number of database queries that a BlackBerry Enterprise Server Express makes to the BlackBerry Configuration Database.

If you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server Express, the BlackBerry database notification system installs automatically.

If you create the BlackBerry Configuration Database on a database server that you installed on a computer that is not the computer that hosts the BlackBerry Enterprise Server Express, you can install the BlackBerry database notification system manually after you complete the BlackBerry Enterprise Server Express installation process.

Before you begin:
- You must have the system administrator permission for the database.
1. On the database server, open the BlackBerry Enterprise Server Express installation files.

2. Perform one of the following actions:
   - If a 32-bit Microsoft SQL Server is running in your organization's environment, in the `Tools\DBNS\x86` folder, copy the `RimEsp.dll` file to `C:\Program Files\Microsoft SQL Server\MSSQL\Binn`.
   - If a 64-bit Microsoft SQL Server is running in your organization's environment, in the `Tools\DBNS\x64` folder, copy the `RimEsp.dll` file to `C:\Program Files(x86)\Microsoft SQL Server\MSSQL\Binn`.

3. Open the Microsoft SQL Server Management Studio.

4. Using the Microsoft SQL Server Management Studio, navigate to `Database\DBInstallScripts\SQLServer\5.0` in the BlackBerry Enterprise Server Express installation files.

5. Open the `NotifyMasterInstall.sql` file.

6. Run the script.

7. Open the `NotifyInstall.sql` file.

8. Change `<_DATABASENAME_>` to the name of the BlackBerry Configuration Database (for example, BesMgmt).

9. Run the script.

10. Confirm that the Microsoft SQL Server Management Studio displays the function `dbo.xp_RIMxxxx` registered message.

11. To add additional BlackBerry Configuration Database instances in your organization's environment, repeat steps 7 to 10.

---

**Best practice: Running the BlackBerry Enterprise Server Express**

<table>
<thead>
<tr>
<th>Best practice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not change the startup type for the BlackBerry Enterprise Server Express services.</td>
<td>When you install or upgrade the BlackBerry Enterprise Server Express, the setup application configures the startup type for the BlackBerry Enterprise Server Express services to automatic or manual. For example, the setup application configures the startup type for the BlackBerry Mail Store Service, BlackBerry Policy Service, and BlackBerry Synchronization Service to manual. To avoid errors in the BlackBerry Enterprise Server Express, do not change the startup type for the BlackBerry Enterprise Server Express services.</td>
</tr>
<tr>
<td>Best practice</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Do not change the account information for BlackBerry Enterprise Server Express services.** | When you install or upgrade the BlackBerry Enterprise Server Express, the setup application configures the account information for the BlackBerry Enterprise Server Express services.  
Do not change the account information for the BlackBerry Enterprise Server Express unless the BlackBerry Enterprise Server Express documentation specifies that you can. |
| **Run the BlackBerry Configuration Panel as an administrator.** | Consider the following guidelines if you are running the BlackBerry Configuration Panel on Windows Server 2008:  
- Log in to the computer with a user account that is in the Administrator group on the Windows Server.  
- Right-click the BlackBerry Configuration Panel icon and click Run as administrator. |

---

# Configuring support for Unicode languages

Configure support for Unicode languages

You can make sure that the messaging application can display the Unicode messages that the BlackBerry device sends by configuring the BlackBerry Enterprise Server Express to support Unicode languages (for example, Japanese, Korean, or Simplified Chinese).

1. On the computer that hosts the BlackBerry Enterprise Server Express, on the taskbar, click **Start > Run**.
2. Type `regedit`.
3. Click **OK**.
4. Perform one of the following actions:
   - If you are running a 32-bit version of Windows, go to `HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion\BlackBerry Enterprise Server\Agents`.
   - If you are running a 64-bit version of Windows, go to `HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Research In Motion\BlackBerry Enterprise Server\Agents`.
5. If the `MAPIEncoding` registry key exists, perform one of the following actions:
   - Delete the key.
6. Perform one of the following actions:
   • If you are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion \BlackBerry Enterprise Server\Setup.
   • If you are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node \Research In Motion\BlackBerry Enterprise Server\Setup.

7. Verify that the **ConfigKeystoreCountry** registry key is set to one of the following values, depending on your organization's environment:
   • CN for Simplified Chinese
   • JP for Japanese
   • KR for Korean

8. In the Windows Services, restart the BlackBerry Dispatcher.

---

### Change the character encoding that the BlackBerry Enterprise Server Express uses to send Unicode messages

By default, when the BlackBerry Enterprise Server Express receives Unicode messages from BlackBerry devices, it uses UTF-8 character encoding to process the Unicode messages. If email applications cannot correctly display Unicode messages that devices send (for example, if email applications cannot display attachment file names or contact lists correctly), you can configure the BlackBerry Enterprise Server Express to select another character encoding to use to process Unicode messages.

**Before you begin:** Configure support for Unicode languages.

1. On the computer that hosts the BlackBerry Enterprise Server Express, on the taskbar, click **Start > Run**.
2. Type **regedit**.
3. Click **OK**.
4. Perform one of the following actions:
   • If you are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion \BlackBerry Enterprise Server\Agents.
   • If you are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node \Research In Motion\BlackBerry Enterprise Server\Agents.
5. Create a DWORD value that is named **AutoSelectOutgoingEncoding**.

6. Double-click the new DWORD value.

7. In the **Value data** field, perform one of the following actions:
   - To configure the BlackBerry Enterprise Server Express to select the most appropriate character encoding when it encodes plain-text messages, type **1**. If the BlackBerry Enterprise Server Express cannot identify which character encoding to use, the BlackBerry Enterprise Server Express encodes plain-text messages in UTF-8.
   - To configure the BlackBerry Enterprise Server Express to select the most appropriate character encoding when it encodes email messages that use RTF or HTML, type **2**. If the BlackBerry Enterprise Server Express cannot identify which character encoding to use, the BlackBerry Enterprise Server Express encodes email messages that use RTF or HTML in UTF-8.
   - To configure the BlackBerry Enterprise Server Express to select the most appropriate character encoding when it encodes plain-text messages and email messages that use RTF or HTML, type **3**. If the BlackBerry Enterprise Server Express cannot identify which character encoding to use, the BlackBerry Enterprise Server Express encodes all email messages in UTF-8.

8. In the Windows Services, restart the BlackBerry Dispatcher.

---

**Configure support for Unicode text in calendars on BlackBerry devices in a Microsoft Exchange environment**

You must complete this task for all Microsoft Exchange versions to ensure calendar items use the correct Unicode characters in fields such as subject, location, or notes.

**Before you begin:** In a Microsoft Exchange 2003 environment, install the following hotfixes for wireless calendar synchronization:

- Visit [http://support.microsoft.com/kb/913643](http://support.microsoft.com/kb/913643) to download and install the required hotfix on the messaging server.
- Visit [http://support.microsoft.com/kb/923537/en-us](http://support.microsoft.com/kb/923537/en-us) to download and install the required hotfix on the computer that will host the BlackBerry Enterprise Server Express.

1. On the BlackBerry Enterprise Server Express, on the **Start** menu, click **Run**.
2. Type **regedit**.
3. Click **OK**.
4. Perform one of the following actions:
   - If you are running a 32-bit version of Windows, navigate to `HKEY_LOCAL_MACHINE\Software\Research In Motion \BlackBerry Enterprise Server\Agents`. 
• If you are running a 64-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\Software\WOW6432Node \Research In Motion\BlackBerry Enterprise Server\Agents.

5. Create a DWORD value that is named **SetLocaleIDs**.
6. Set the value to **1**.
7. In the Windows Services, restart the BlackBerry Messaging Agent.

### Configuring the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services

By default, the BlackBerry Enterprise Server Express uses Microsoft Exchange Web Services to manage calendars on BlackBerry devices. The BlackBerry Enterprise Server Express monitors periodically whether a user account can use Microsoft Exchange Web Services. If a user account cannot use Microsoft Exchange Web Services, for example, because of a configuration error in Microsoft Exchange, the BlackBerry Enterprise Server Express uses MAPI and CDO libraries to manage calendars on devices. A BlackBerry Messaging Agent on the BlackBerry Enterprise Server Express can include a dynamic mix of user accounts that use Microsoft Exchange Web Services and user accounts that use MAPI and CDO libraries.

You can use the BlackBerry Enterprise Trait Tool to configure the BlackBerry Enterprise Server Express to use only Microsoft Exchange Web Services or only MAPI and CDO libraries to manage calendars on devices. You can configure a specific BlackBerry Messaging Agent instance, a specific BlackBerry Enterprise Server Express instance, or all BlackBerry Enterprise Server Express instances that share one BlackBerry Configuration Database.

To use Microsoft Exchange Web Services, your organization’s environment must include Microsoft Exchange 2007 SP1 or later.


For more information about configuring the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services, see the *BlackBerry Enterprise Server Express Administration Guide*.
Prerequisites: Configuring the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services

- Install an SSL certificate on a BlackBerry Enterprise Server Express so that the BlackBerry Enterprise Server Express can communicate with Microsoft Exchange Web Services. You must export the SSL certificate from the client access server for Microsoft Exchange and import the SSL certificate to the BlackBerry Enterprise Server Express. The BlackBerry Enterprise Server Express supports a self-signed security certificate or a certificate that a certificate authority issues. For more information about installing an SSL certificate, visit support.microsoft.com to read article KB 962624.


- Assign IIS permissions to a BlackBerry Enterprise Server Express administrator account on the Microsoft Exchange Server that hosts the client access server role. For more information about assigning IIS permissions, visit support.microsoft.com to read article KB 816117.

Configure the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services

You can configure the BlackBerry Enterprise Server Express to use only Microsoft Exchange Web Services to manage calendars on BlackBerry devices.

1. Copy the BlackBerry Enterprise Server Express installation files to the computer that hosts the BlackBerry Enterprise Server Express.

2. Extract the contents to a folder on the computer.

3. At a command prompt, navigate to <extracted_folder>\tools.

4. Perform one of the following actions:
   - To configure a specific BlackBerry Messaging Agent on a specific BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services, type `traittool -server <server_name> -agent <agent_id> -trait EWSEnable -set true`, where `<server_name>` is the name of the BlackBerry Enterprise Server Express and `<agent_id>` is the ID for the BlackBerry Messaging Agent.
   - To configure all BlackBerry Messaging Agent instances on a specific BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services, type `traittool -server <server_name> -trait EWSEnable -set true`, where `<server_name>` is the name of the BlackBerry Enterprise Server Express.
• To configure all BlackBerry Messaging Agent instances on all BlackBerry Enterprise Server Express instances to use Microsoft Exchange Web Services, type `traittool -global -trait EWSEnable -set true`.

5. Restart the BlackBerry Messaging Agent instances that you made changes to.

**After you finish:**

In the logs folder verify that the file named `<server_name>_CALH_<agent_id>_<date>.txt` appears. In the file name, `<server_name>` is the name of the BlackBerry Enterprise Server Express, `<agent_id>` is the ID of the BlackBerry Messaging Agent, and `<date>` is the date that you configured the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services.

---

**Manage the BlackBerry Enterprise Server Express performance in a Microsoft Exchange 2010 environment**

**Before you begin:**

You must install version 6.5.8211.0 of the Microsoft Exchange Server MAPI Client and CDO 1.2.1 on the BlackBerry Enterprise Server Express computer. For more information, visit [www.microsoft.com/downloads](http://www.microsoft.com/downloads) to read the article named "Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1".

1. Verify that you configured Microsoft Exchange 2010 performance as suggested by Microsoft. For more information, visit [technet.microsoft.com](http://technet.microsoft.com) to read "Understanding the Mailbox Database Cache" in the Microsoft Exchange 2010 SP1 help.

2. If necessary for your organization’s environment, verify that you installed the Microsoft hotfixes that are located in the following articles:
   - 2155311
   - 979149

   For more information about the hotfixes, visit [support.microsoft.com](http://support.microsoft.com).

3. Configure the BlackBerry Enterprise Server Express to use LDAP to retrieve email addresses and organizer data. For more information, see "Configuring the BlackBerry Enterprise Server Express to use LDAP to retrieve email addresses and organizer data" in the `BlackBerry Enterprise Server Express Administration Guide`.

4. Configure the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services to manage calendars on devices. For more information, see "Configuring the BlackBerry Enterprise Server Express to use Microsoft Exchange Web Services or MAPI and CDO libraries" in the `BlackBerry Enterprise Server Express Administration Guide`.
Log in to the BlackBerry Administration Service for the first time

To open the BlackBerry Administration Service, you can use a browser on any computer that has access to the computer that hosts the BlackBerry Administration Service.

**Before you begin:** To manage a BlackBerry device using the BlackBerry Administration Service while the BlackBerry device is connected to the computer, the browser must permit Microsoft ActiveX controls.

1. In the browser, type `https://<server_name>:<https_port>/webconsole/app`, where `<server_name>` is the name of the computer that hosts the BlackBerry Administration Service.

2. In the **User name** field, type `admin`.

3. In the **Password** field, type the password that you created during the installation process.

4. In the **Log in using** drop-down list, click **BlackBerry Administration Service** or **Active Directory Authentication**.

5. Click **Log in**.

There is a problem with this website's security certificate

**Description**

The browser displays this error message when you try to navigate to the BlackBerry Administration Service using Windows Internet Explorer version 7 or later.

**Possible solution**

Add the web address for the BlackBerry Administration Service to the list of trusted web sites in Windows Internet Explorer, and install the certificate for the BlackBerry Administration Service in the certificate store of your computer.

1. In Windows Internet Explorer, navigate to the BlackBerry Administration Service console.

2. Click **Continue to this website (not recommended)**.

3. On the **Tools** menu, click **Internet Options**.

4. On the **Security** tab, click **Local Intranet**.

5. Click **Sites**.

6. Click **Add** to add the console to the list of trusted web sites.
7. Click Close.
8. Click OK.
9. In the browser window, on the toolbar, click Certificate Error.
10. Click View certificates.
12. Complete the instructions in the Certificate Import Wizard. If you are trying to log in to the BlackBerry Administration Service using a computer that runs Windows Vista, perform the following actions in the Certificate Import Wizard.
   a. In the Certificate Store dialog box, click Place all certificates in the following store.
   b. Click Browse.
   c. Click Trusted Root Certification Authorities.
   d. Click OK.
13. Close and reopen the browser.

Configuring communication with distributed components

Connecting to a BlackBerry Attachment Service

Perform the following actions if you installed the BlackBerry Attachment Service on a computer that is separate from the computer that host the BlackBerry Enterprise Server Express or BlackBerry Enterprise Server Express components that connect to the BlackBerry Attachment Service. These actions ensure that BlackBerry Enterprise Server Express components can connect to the BlackBerry Attachment Service.

Connect a BlackBerry MDS Connection Service to a remote BlackBerry Attachment Service

Perform the following task if you did not install the BlackBerry Attachment Service on the same computer as the BlackBerry MDS Connection Service.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain > Component view > Attachment > Connector.
2. Click the BlackBerry Attachment Connector that is installed with the BlackBerry MDS Connection Service.
3. Click Edit instance.
4. On the **Supported Attachment Server instances** tab, in the **Name** drop-down list, select the BlackBerry Attachment Service instance that you want to connect the BlackBerry MDS Connection Service to.

5. In the **Results query period(s)** field, type the number of seconds that you want the BlackBerry MDS Connection Service to wait for a response before it sends a request to another BlackBerry Attachment Service instance.

6. In the **Dedicated server** drop-down list, click **yes** if you want the BlackBerry Attachment Service instance to process specific content types only for the BlackBerry MDS Connection Service.

7. In the **Pool** drop-down list, click **Primary**.

8. Perform the following actions:
   - To turn on support for an attachment file format, in the **Extensions** section, type the file extension of the format. Click the **Add** icon beside the extension that you typed.
   - To turn off support for an attachment file format, in the **Extensions** section, click the **Delete** icon beside the file extension.

9. Click the **Add** icon.

10. Click **Save All**.

11. Repeat steps 2 to 10 for each BlackBerry MDS Connection Service instance in your organization's environment that requires the BlackBerry Attachment Service instance.

**Connect a BlackBerry Enterprise Server Express to a remote BlackBerry Attachment Service**

Perform the following actions if you did not install the BlackBerry Attachment Service on the same computer as the BlackBerry Enterprise Server Express. The BlackBerry Messaging Agent requires access to the remote BlackBerry Attachment Service so that it can process attachment requests.

1. In the BlackBerry Administration Service, on the **Servers and components** menu, expand **BlackBerry Solution topology > BlackBerry Domain > Component view > Attachment > Connector**.

2. Click the BlackBerry Attachment Connector that is installed with the BlackBerry Enterprise Server Express.

3. Click **Edit instance**.

4. On the **Supported Attachment Server instances** tab, in the **Name** drop-down list, select the BlackBerry Attachment Service instance that you want to connect to the BlackBerry Enterprise Server Express.

5. In the **Results query period(s)** field, type the number of seconds that you want the BlackBerry Enterprise Server Express to wait for a response before it sends a request to another BlackBerry Attachment Service instance.

6. In the **Dedicated server** drop-down list, click **yes** if you want the BlackBerry Attachment Service instance to process specific content types only for the BlackBerry Enterprise Server Express.

7. In the **Pool** drop-down list, select **Primary**.

8. Perform the following actions:
To turn on support for an attachment file format, in the Extensions section, type the file extension of the format. Click the Add icon beside the extension that you typed.

To turn off support for an attachment file format, in the Extensions section, click the Delete icon beside the file extension.

9. Click the Add icon.

10. Click Save All.

11. Repeat steps 2 to 10 for each BlackBerry Enterprise Server Express instance in your organization's environment that requires the BlackBerry Attachment Service instance.

12. Restart the BlackBerry Enterprise Server Express.
   a. In the Component view, expand BlackBerry Enterprise Server.
   b. Click the BlackBerry Enterprise Server Express instance.
   c. Click Restart instance.

Connect a remote BlackBerry Attachment Service to a BlackBerry Enterprise Server Express

Perform the following actions if you did not install the BlackBerry Attachment Service on the same computer as the BlackBerry Enterprise Server Express. The BlackBerry Messaging Agent requires access to the remote BlackBerry Attachment Service so that it can process attachment requests.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain > Component view > Attachment > Server.

2. Click the name of the remote BlackBerry Attachment Service.

3. Click Edit instance.

4. On the Supported Attachment Connector instances tab, add the BlackBerry Attachment Connector that is installed with the BlackBerry Enterprise Server Express.

5. Click Save All.

6. To restart the BlackBerry Attachment Service, on the Instance information tab, in the Status list, click Restart instance.

Connecting to a BlackBerry Router

Perform the following tasks if you installed the BlackBerry Router on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server Express. These tasks ensure that the BlackBerry Enterprise Server Express can connect to the BlackBerry Router.
Permit a BlackBerry Enterprise Server Express to connect to a remote BlackBerry Router

If you installed a BlackBerry Router on a computer that is separate from the computer that hosts a BlackBerry Enterprise Server Express, you must permit the BlackBerry Dispatcher that you installed with the BlackBerry Enterprise Server Express to connect to the BlackBerry Router. The BlackBerry Router that you installed on a separate computer can send data packets from the BlackBerry Enterprise Server Express to BlackBerry devices.

1. On the computer that hosts the BlackBerry Router, click **Start > Run**.
2. Type `regedit`.
3. Click **OK**.
4. Perform one of the following actions:
   • If you are running a 32-bit version of Windows, navigate to `\HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion\BlackBerryRouter`.
   • If you are running a 64-bit version of Windows, navigate to `\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Research In Motion\BlackBerryRouter`.
5. Verify the value of **AllowRemoteServices** is **1**.
6. If you want to change the port number that the BlackBerry Router uses to open connections to the BlackBerry Dispatcher, change the value of **ServicePort** to the port number that the BlackBerry Router should use, for example, port number 80. By default, the port number is 3101.
7. In the Windows Services, restart the BlackBerry Router service.

Connect a BlackBerry Enterprise Server Express to a remote BlackBerry Router

1. In the BlackBerry Administration Service, on the **Servers and components** menu, expand **BlackBerry Solution topology > BlackBerry Domain > Component view > BlackBerry Enterprise Server**.
2. Click the BlackBerry Enterprise Server Express instance or BlackBerry Enterprise Server Express pair that you want to assign the BlackBerry Router to.
3. Click **Edit instance**.
4. In the **Router address** section, type the FQDN of the computer that hosts the BlackBerry Router.
5. If the BlackBerry Router uses a port number other than port number 3101, in the **Port override** field, type the port number.
6. Click the **Add** icon.
7. Click **Save All**.
8. Restart the BlackBerry Enterprise Server Express using one of the following methods:
• If you changed a BlackBerry Enterprise Server Express instance, on the **Instance** tab, click **Restart instance**.

• If you changed a BlackBerry Enterprise Server Express pair, click one of the instances and on the **Instance** tab, click **Restart instance**. Repeat this step for the other instance.

• In the Windows Services, restart the BlackBerry Dispatcher.

## Restrict database permissions for the BlackBerry Attachment Service

The BlackBerry Attachment Service accesses the BlackBerry Configuration Database to read attachment data using a Windows account or a SQL authentication account. To limit the access that the BlackBerry Attachment Service account has to the tables in the BlackBerry Configuration Database, you can configure a BlackBerry Attachment Service account that has limited database permissions. This account is not the same as the account that the BlackBerry Enterprise Server Express uses to access the BlackBerry Configuration Database.

**Before you begin:**

- Create a Windows account for the BlackBerry Attachment Service.
- To use database authentication, create a SQL authentication account for the BlackBerry Attachment Service.

1. In the Microsoft SQL Server management console, create a SQL login for the Windows account or SQL authentication account.

2. Assign the account to the `rim_db_AttachmentServer` role in the BlackBerry Configuration Database.

3. If you want the BlackBerry Attachment Service to use a SQL authentication account to access the BlackBerry Configuration Database, perform the following actions:
   a. On the computer that you installed the BlackBerry Attachment Service on, log in using the Windows account that the BlackBerry Attachment Service is running on.
   b. Click **Start > Run**.
   c. Type `regedit`. Click **OK**.
   d. If you are running a 32-bit version of Windows, navigate to **HKEY_CURRENT_USER\SOFTWARE\Research In Motion**.
   e. If you are running a 64-bit version of Windows, navigate to **HKEY_CURRENT_USER\SOFTWARE \WOW6432Node\Research In Motion**.
   f. Create the `BBAttachServer\Database keys`.
   g. In the Database key, create the **Login** and **Password** string values for the SQL authentication account.
After you finish: After you complete the BlackBerry Attachment Service installation process, in the Windows Services, verify that the service for the BlackBerry Attachment Service is using the Windows account that you configured. If you need to change the account information, restart the BlackBerry Attachment Service.

Configuring minimum Microsoft SQL Server permissions for the Windows account

The BlackBerry Enterprise Server Express setup application requires the Windows account that it uses during the installation process or upgrade process to have Microsoft SQL Server permissions to create or upgrade the BlackBerry Configuration Database. The setup application requires the Windows account to have more Microsoft SQL Server permissions to install the BlackBerry Enterprise Server Express than the BlackBerry Enterprise Server Express requires to run.

After the installation or upgrade process completes, you can change the Microsoft SQL Server permissions of the Windows account to the Microsoft SQL Server permissions that the BlackBerry Enterprise Server Express requires to run. When you change the Microsoft SQL Server permissions of the Windows account, you can use Microsoft SQL Server security to minimize the operations that the Windows account can perform on the BlackBerry Configuration Database.

The following table describes the Microsoft SQL Server permissions for the setup application and the Windows account that the BlackBerry Enterprise Server Express uses to run.

<table>
<thead>
<tr>
<th>Server and database roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>db_owner</td>
<td>The setup application requires this role to upgrade the BlackBerry Configuration Database.</td>
</tr>
<tr>
<td></td>
<td>This role is the default permission in Microsoft SQL Server for running the BlackBerry Enterprise Server Express.</td>
</tr>
<tr>
<td>rim_db_bes_server</td>
<td>The setup application or the createDB executable creates the role automatically when it creates the BlackBerry Configuration Database.</td>
</tr>
<tr>
<td></td>
<td>This role is the minimum permission in Microsoft SQL Server for running the BlackBerry Enterprise Server Express.</td>
</tr>
</tbody>
</table>

Configure minimum Microsoft SQL Server permissions for the Windows account

You can configure the minimum Microsoft SQL Server permissions for the Windows account that the BlackBerry Enterprise Server Express uses to run.

1. Open the Microsoft SQL Server console.
2. Expand **Microsoft SQL Server > Security > Logins**.

3. Right-click the Windows account that the BlackBerry Enterprise Server Express uses to run. Click **Properties**.

4. Map the Windows account to the BlackBerry Configuration Database.

5. Change the **Database role membership** to **rim_db_bes_server**.

6. Remove all other database role memberships.

7. Apply your changes.

---

### Changing the BlackBerry Configuration Database

If you want a BlackBerry Enterprise Server Express to use a different BlackBerry Configuration Database, you must run the setup application and specify the BlackBerry Configuration Database that you want the BlackBerry Enterprise Server Express to use.

When you change the BlackBerry Configuration Database, the BlackBerry Enterprise Server Express becomes unavailable and users cannot send or receive messages on their BlackBerry devices. Organizer data synchronization occurs after you have changed the BlackBerry Configuration Database.

---

### Instructing users with personal BlackBerry devices to use the BlackBerry Desktop Software to manage personal and work data

You can add BlackBerry device users that have personal BlackBerry devices that are associated with the BlackBerry Internet Service to the BlackBerry Enterprise Server Express. You must instruct the users to use their personal BlackBerry Desktop Software to manage personal data synchronization settings, and the BlackBerry Desktop Software or BlackBerry Web Desktop Manager that was distributed by their organization to manage synchronization settings for work data. Data conflicts should not occur on devices if users manage personal data settings using their personal BlackBerry Desktop Software and work data settings using the BlackBerry Desktop Software that was distributed by their organization.
Adding or removing BlackBerry Enterprise Server Express components

If you installed a BlackBerry Enterprise Server Express previously, you can add one or more BlackBerry Enterprise Server Express components to the existing BlackBerry Enterprise Server Express, or you can remove existing BlackBerry Enterprise Server Express components from the BlackBerry Enterprise Server Express.

To add or remove a BlackBerry Enterprise Server Express component, you must run the setup application again. The setup application removes the existing BlackBerry Enterprise Server Express software from the computer, and installs only the BlackBerry Enterprise Server Express components that you select. You can also choose to install either a BlackBerry Enterprise Server Express or install one or more remote components.

If you installed a BlackBerry Enterprise Server Express and, when you run the setup application again you select the remote component setup option, the setup application removes the existing BlackBerry Enterprise Server Express software. If you installed one or more remote components and you select the BlackBerry Enterprise Server Express setup option, the setup application removes the existing remote components.

You can add or remove the following BlackBerry Enterprise Server Express components.

<table>
<thead>
<tr>
<th>Component</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>BlackBerry Enterprise Server Express</td>
<td>You can choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• You can remove a BlackBerry Enterprise Server Express (which includes a BlackBerry Attachment Service, BlackBerry Dispatcher, BlackBerry MDS Connection Service, BlackBerry Messaging Agent, BlackBerry Policy Service, BlackBerry Router, and BlackBerry Synchronization Service) and install one or more remote components instead.</td>
</tr>
<tr>
<td></td>
<td>• You can remove any remote components and install a BlackBerry Enterprise Server Express instead.</td>
</tr>
<tr>
<td>BlackBerry Administration Service</td>
<td>You can choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry Administration Service with a BlackBerry Enterprise Server Express, you can remove the BlackBerry Administration Service.</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry Enterprise Server Express, you can add a BlackBerry Administration Service.</td>
</tr>
<tr>
<td>Component</td>
<td>Options</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| BlackBerry Administration Service        | • If you installed a BlackBerry Administration Service as a remote component, you can remove it.  
                                          | • If you installed remote components, you can add a BlackBerry Administration Service. |
| BlackBerry Attachment Service            | You can choose one of the following options:                          |
|                                          | • If you installed a BlackBerry Attachment Service as a remote component, you can remove it.  
                                          | • You can add a BlackBerry Attachment Service to an existing installation of another remote component. |
| BlackBerry MDS Connection Service        | You can choose one of the following options:                          |
|                                          | • If you installed a BlackBerry MDS Connection Service as a remote component, you can remove it.  
                                          | • You can add a BlackBerry MDS Connection Service to an existing installation of another remote component. |
| BlackBerry Router                        | You can choose one of the following options:                          |
|                                          | • If you installed a BlackBerry Router as a remote component, you can remove it.  
                                          | • You can add a BlackBerry Router to an existing installation of another remote component. |

Add or remove a BlackBerry Enterprise Server Express component

The BlackBerry Enterprise Server Express components on the computer that you perform this task on are unavailable for use until the installation process is complete and you restart the BlackBerry Enterprise Server Express services.

The process includes a restart of a BlackBerry Enterprise Server Express.

**Before you begin:** If you want to remove a BlackBerry Router, BlackBerry Attachment Service, or BlackBerry MDS Connection Service, use the BlackBerry Administration Service to remove the component from the list of components that the BlackBerry Enterprise Server Express can use.
1. Log in to a computer using the Windows account that you used to install the BlackBerry Enterprise Server Express components.

2. In the BlackBerry Enterprise Server Express installation files, double-click `setup.exe`. If the operating system in your organization’s environment is Windows Server 2008 or later or Windows Small Business Server 2008 or later, run `setup.exe` as an administrator.

3. Accept the BlackBerry Enterprise Server Express license agreement. Click **Next**.

4. In the **Database information** dialog box, verify that the information is correct. Click **Next**.

5. In the **Setup options** dialog box, in the **Components** section, select the BlackBerry Enterprise Server Express components that you want to install. The setup application upgrades any components that you previously installed that you select. The components might be unavailable for BlackBerry device users during the installation process. If you installed a BlackBerry Enterprise Server Express component on the computer previously, the component is selected. If you clear the check mark for the component, the setup application removes the component from the computer.

6. Click **Next**.

7. In the **Preinstallation checklist** dialog box, perform one of the following actions:
   - To continue, click **Next**.
   - To complete requirements that were identified in the checklist, click **Cancel**. You can restart the installation or upgrade at a later time.

8. In the **Accounts and Folders** dialog box, in the **Windows account information** section, in the **Password** field, type the password for the Windows account that you are using to install or remove the BlackBerry Enterprise Server Express components. Click **Next**.

9. In the **Summary** dialog box, verify the setup information.

10. Click **Install** to start the installation process.

11. Perform one of the following actions:
    - If the setup application prompts you to restart the computer, click **Yes**. After the computer restarts, log in to the computer using the same account that you used in step 1.
    - If the setup application does not prompt you to restart the computer, after the setup application installs the necessary components, click **Continue**.

12. If necessary, in the **BlackBerry CAL and SRP information** dialog box, verify that the information is correct. If you change any information, click **Verify** to verify that the information that you change is correct. Click **Next**.

13. If necessary, in the **Administration settings** dialog box, verify the settings.

14. If necessary, in the **Password for the SSL certificate** section, type and confirm a password for the SSL certificate that the setup application creates to establish communication between the BlackBerry Administration Service and web browsers that you use to access the BlackBerry Administration Service. Click **Next**.

15. In the **Microsoft® Active Directory® settings** dialog box, in the **User password** field, type the password for the Microsoft Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server Express uses to
authenticate with Microsoft Active Directory. If you want to specify a different username and Windows domain, you must make sure that the Windows domain belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.

16. In the **Advanced administration settings** dialog box, perform one of the following actions:

- If you select **Use Windows authentication**, you can choose to use the Microsoft Active Directory account that you used in the previous step, or you can specify login information for a Microsoft Active Directory administrator.

- If you select **Use BlackBerry Administration Service authentication**, type and confirm a password for the BlackBerry Administration Service administrator account.

You use the login information that you specify to log in to the BlackBerry Administration Service for the first time.

17. In the **Start services** dialog box, click **Start Services**. When all of the BlackBerry Enterprise Server Express services start, click **Next**.

18. In the **Console addresses** dialog box, click **Finish**. By default, the setup application writes the BlackBerry Administration Service and the BlackBerry Web Desktop Manager web addresses to a .txt file.

**After you finish:**

- If you added a component, to view the component information in the BlackBerry Administration Service, perform one of the following actions:

  - Restart the BlackBerry Administration Service.

  - On every computer that hosts the BlackBerry Administration Service, in the BlackBerry Administration Service, in the **Servers and components** menu, expand **BlackBerry Solution topology > BlackBerry Domain**. Click **Component view** and then click **Refresh list of registered components**.

- If you removed a component other than the BlackBerry Router, to delete the component information from the BlackBerry Configuration Database, use the BlackBerry Administration Service.

- If you reinstalled the BlackBerry Administration Service, in Windows Internet Explorer, delete the cache content.

- The size of log files for the BlackBerry Enterprise Server Express components varies based on the number of users in your BlackBerry Enterprise Server Express environment and the level of user activity. It is a best practice to monitor and control the amount of disk space taken up by the BlackBerry Enterprise Server Express log files. For more information about configuring logging, visit [www.blackberry.com/go/serverdocs](http://www.blackberry.com/go/serverdocs) to see the *BlackBerry Enterprise Server Express Administration Guide*.
Remove BlackBerry Enterprise Server Express component information from the BlackBerry Configuration Database

If you remove the software for a BlackBerry Enterprise Server Express component from a computer, the software removal process does not delete the component information from the BlackBerry Configuration Database. You must delete the information manually using the BlackBerry Administration Service so that the BlackBerry Administration Service does not display the information for the component that you removed.

Before you begin: Remove the software for the BlackBerry Enterprise Server Express component from the computer.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain.
2. Click Component view.
3. Beside the component that you removed, which appears as Uninstalled, click the Delete icon.
4. Click Yes - Delete the instance and wait until you return to the main page.
Removing the BlackBerry Enterprise Server Express software

Remove the BlackBerry Enterprise Server Express software

1. On the taskbar, click **Start > Settings > Control Panel > Add/Remove Programs**.
2. Click **BlackBerry Enterprise Server Express**.
3. Click **Remove**.
4. Click **Yes**.

**After you finish:** To remove third-party software that the setup application installed during the BlackBerry Enterprise Server Express installation process, you can remove the JRE software and Java Web Start software from the computer.

Delete registry keys

The BlackBerry Enterprise Server Express setup application might not remove all of the registry keys from the Windows registry when you remove the BlackBerry Enterprise Server Express software. You can remove the registry keys from the Windows registry manually after the process to remove the BlackBerry Enterprise Server Express software completes successfully.

1. On the computer that you removed the BlackBerry Enterprise Server Express software from, on the **Start** menu, click **Run**.
2. Type **regedit**.
3. Click **OK**.
4. Delete the remaining registry keys.
# BlackBerry Enterprise Server Express registry keys

The setup application might not remove the following BlackBerry Enterprise Server Express registry keys from the Windows Registry when you remove the BlackBerry Enterprise Server Express software.

<table>
<thead>
<tr>
<th>Key</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Research In Motion</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE (32-bit OS)</td>
</tr>
<tr>
<td></td>
<td>HKEY_LOCAL_MACHINE\Wow6432Node\SOFTWARE (64-bit OS)</td>
</tr>
<tr>
<td>BBAttachServer and any keys that start with BAS, BB, or BlackBerry</td>
<td>HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services</td>
</tr>
<tr>
<td>BBAttachServer and any keys that start with BAS, BB, or BlackBerry</td>
<td>HKEY_LOCAL_MACHINE\System\ControlSet001\Services</td>
</tr>
<tr>
<td>BBAttachServer and any keys that start with BAS, BB, or BlackBerry</td>
<td>HKEY_LOCAL_MACHINE\System\ControlSet00n\Services</td>
</tr>
<tr>
<td>Research In Motion</td>
<td>HKEY_CURRENT_USER\Software</td>
</tr>
<tr>
<td>any keys that are named BlackBerryServer, or are named the name of the BlackBerry Enterprise Server Express in your organization</td>
<td>HKEY_CURRENT_USER\Software\Microsoft\Windows NT \CurrentVersion\Windows Messaging SubSystem\Profiles</td>
</tr>
<tr>
<td>Research In Motion</td>
<td>HKEY_USERS.DEFAULT\Software</td>
</tr>
<tr>
<td>BESManmmmc.dll</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows \CurrentVersion\App Paths</td>
</tr>
<tr>
<td>any key where ProductName is BlackBerry Enterprise Server</td>
<td>HKEY_CLASSES_ROOT\Installer\Products</td>
</tr>
</tbody>
</table>
Removing the BlackBerry database notification system

You must remove the BlackBerry database notification system manually if you installed it manually. You can remove the BlackBerry database notification system from one BlackBerry Configuration Database instance or all BlackBerry Configuration Database instances.

Remove the BlackBerry database notification system from a BlackBerry Configuration Database

1. Open the Microsoft SQL Server Management Studio.
2. Using the console, navigate to Database\DBInstallScripts\SQLServer\5.0 in the BlackBerry Enterprise Server Express installation files.
3. Open the NotifyUnInstall.sql file.
4. Delete all commands after `--- delete notification stored procedures` and `-- delete notification tables`.
5. Run the script.
6. Perform one of the following actions:
   - Restart Microsoft SQL Server.
   - In Windows Explorer, navigate to C:\Program Files\Microsoft SQL Server\MSSQL\Binn. Rename the RimEsp.dll file (for example, RimEspXXX.tmp).

Remove the BlackBerry database notification system from all BlackBerry Configuration Database instances

1. Open the Microsoft SQL Server Management Studio.
2. Using the console, navigate to Database\DBInstallScripts\SQLServer\5.0 in the BlackBerry Enterprise Server Express installation files.
3. Open the NotifyUnInstall.sql file.
4. Run the script.
5. Using Windows Explorer, navigate to `<drive>:\Program Files\Microsoft SQL Server\MSSQL\Binn`.

6. Delete the **RimEsp.dll** file.
Troubleshooting the BlackBerry Enterprise Server Express installation process

Failed to write License Key to the Database

This error message appears when you try to add the BlackBerry Client Access License key during the installation process.

Possible solution
After you restart the computer during the BlackBerry Enterprise Server Express installation process, you must log in using the same Windows account that you used to start the installation process.

1. Close the setup application.
2. Log out of the computer.
3. Log in to the computer.
4. Restart the setup application.

Previous version detected but no database available

This error message appears when you cannot start the setup application or the setup application stops responding.

Possible solution
Verify that the registry keys that identify the BlackBerry Configuration Database exist in the Windows registry.

1. On the computer that you want to install or upgrade the BlackBerry Enterprise Server Express on, on the Start menu, click Run.
2. Type `regedit`.
3. Click OK.
4. In the left pane, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server Database.
5. If necessary, create case-sensitive strings that you name `DatabaseName` and `DatabaseServerMachineName`.
6. Specify the name of the BlackBerry Configuration Database as the value for `DatabaseName`.
7. Specify the FQDN name of the database server as the value for `DatabaseServerMachineName`.
8. Restart the setup application.

A third-party tool did not install and the BlackBerry Enterprise Server Express setup application closed

Possible solution
1. On the BlackBerry Enterprise Server Express installation media, open the Tools folder.
2. Double-click the setup application file for the tool that you want to install.
3. Complete the instructions on the screen.
4. Restart the BlackBerry Enterprise Server Express setup application.

The setup application did not prompt you to change or confirm the MAPI profile

Possible solution
Create and change the MAPI profile manually.
1. On the BlackBerry Enterprise Server Express installation media, open the Tools folder.
2. Double-click the `Fixmapisvc.exe` file.
3. Verify that `mapisvc.inf` is installed in C:\winnt\system32\ or C:\windows\system32\.
4. On the taskbar, click Start > All Programs > BlackBerry Enterprise Server > BlackBerry Server Configuration.
5. On the BlackBerry Server tab, click Edit MAPI profile.
6. Type the Microsoft Exchange server name.
7. Click the Windows account that is associated with the MAPI profile.
8. Click OK.

You cannot determine the BlackBerry Attachment Connector that the BlackBerry Enterprise Server Express or the BlackBerry MDS Connection Service uses

If you install a BlackBerry Enterprise Server Express, the setup application also installs two BlackBerry Attachment Connector instances automatically. One of the BlackBerry Attachment Connector instances connects the BlackBerry Enterprise Server Express to the BlackBerry Attachment Service. The other instance connects the BlackBerry MDS Connection Service to the BlackBerry Attachment Service. During the installation process, the setup application gives both BlackBerry Attachment Connector instances a name that includes the computer name (for example, <computer_name>_AC).

The BlackBerry Administration Service displays the names of both the BlackBerry Attachment Connector instances. By default, you cannot determine easily which instance connects to the BlackBerry Enterprise Server Express or the BlackBerry MDS Connection Service, so you can change the display names of both the BlackBerry Attachment Connector instances to make them easier to identify.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain > Component view > Attachment > Connector.
2. Click one of the BlackBerry Attachment Connector instances.
3. On the Instance information tab, locate either the MDS Connection Service Instance name section or the Email (Exchange) Instance name section. Consider the following naming conventions:
   - If you locate the section that is named MDS Connection Service Instance name, the BlackBerry MDS Connection Service connects to this BlackBerry Attachment Connector instance.
   - If you locate the section that is named Email (Exchange) Instance name, the BlackBerry Enterprise Server Express connects to this BlackBerry Attachment Connector instance.
4. Click Edit instance.
5. Perform one of the following actions:

- If the BlackBerry MDS Connection Service connects to the BlackBerry Attachment Connector instance, in the Instance information section, in the Friendly description field, type a unique name (for example, <server_name>_AC_MDSCS).
- If the BlackBerry Enterprise Server Express uses the BlackBerry Attachment Connector instance, in the Instance information section, in the Friendly description field, type a unique name.

6. Click Save all.

The BlackBerry Administration Service updates the list of BlackBerry Attachment Connector instances automatically to use the names that you typed.

**Users experience unexpected behavior with message lists and calendars on BlackBerry devices**

**Possible cause**

If the MAPI and CDO client version 6.5.8022 was installed without uninstalling previous versions of the MAPI and CDO client (including the associated .DLL files), users might experience unexpected behavior with message lists and calendars on BlackBerry devices.

**Possible solution**

For more information about Microsoft Exchange Server MAPI Client and CDO version 1.2.1, visit [www.microsoft.com](http://www.microsoft.com).

1. In the Windows Services, stop the services for the BlackBerry Enterprise Server Express and any processes that use the MAPI and CDO client.

2. Remove the MAPI and CDO client version 6.5.8022.

3. Verify that the following files are not present in C:\Windows\System32 or any other directory in the environment path:

   - CDO.DLL
   - EMSABP32.DLL
   - EMSMDB32.DLL
   - EMSUI32.DLL
   - EMSUIX32.DLL
   - GAPI32.DLL
In C:\Windows\System32, run the FixMapi.exe application.

5. Install the MAPI and CDO client version 6.5.8022.

6. Restart the services for the BlackBerry Enterprise Server Express and any processes that use the MAPI and CDO client.

If you run the BlackBerry Enterprise Server Express setup application after you complete the possible solution, when the setup application displays the preinstallation checklist, an error message indicates that the setup application could not detect the MAPI and CDO client. The setup application displays this error message because you installed the MAPI and CDO client version 6.5.8022 in a different directory than the directory that you installed it in for previous versions. The error message does not prevent the BlackBerry Enterprise Server Express setup application from completing the installation process successfully.

Some BlackBerry Enterprise Server Express components do not start

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Possible solution</th>
</tr>
</thead>
</table>
| The BlackBerry Administration Service and BlackBerry MDS Connection Service are configured to use a dynamic port when they connect to the BlackBerry Configuration Database, but the database server uses a static port. | Configure a static port for the BlackBerry Configuration Database.  
1. On the computer that hosts the BlackBerry Enterprise Server Express component, on the taskbar, click **Start > All Programs > BlackBerry Enterprise Server**.  
2. Right-click **BlackBerry Server Configuration** and select **Run as administrator**.  
3. On the **Database Connectivity** tab, clear the **Use dynamic ports or specify SQL port** check box.  
4. In the **Use dynamic ports or specify SQL port** field, type the correct port number.  
5. Click **OK**.  
6. In the Windows Services, restart the services for the BlackBerry Enterprise Server Express component. |
<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Possible solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The BlackBerry Administration Service and BlackBerry MDS Connection Service are configured to use an incorrect static port number when they connect to the BlackBerry Configuration Database.</td>
<td>Configure the component to use the correct port number.</td>
</tr>
<tr>
<td>1. On the computer that hosts the BlackBerry Enterprise Server Express component, on the taskbar, click Start &gt; All Programs &gt; BlackBerry Enterprise Server.</td>
<td></td>
</tr>
<tr>
<td>2. Right-click BlackBerry Server Configuration and select Run as administrator.</td>
<td></td>
</tr>
<tr>
<td>3. On the Database Connectivity tab, clear the Use dynamic ports or specify SQL port check box.</td>
<td></td>
</tr>
<tr>
<td>4. In the Use dynamic ports or specify SQL port field, type the correct port number.</td>
<td></td>
</tr>
<tr>
<td>5. Click OK.</td>
<td></td>
</tr>
<tr>
<td>6. In the Windows Services, restart the services for the BlackBerry Enterprise Server Express component.</td>
<td></td>
</tr>
</tbody>
</table>

You cannot access the BlackBerry Administration Service

Possible cause
The computer that hosts the BlackBerry Administration Service has more than one NIC and the production NIC is not first in the bind order in Windows network settings as it must be for you to access the BlackBerry Administration Service.

Possible solution
On the computer that hosts the BlackBerry Administration Service, in the Windows network settings, verify that the production NIC is first in the bind order. For more information, visit www.blackberry.com/btsc to read article KB18190.
You cannot create a user account in the BlackBerry Administration Service

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Possible solution</th>
</tr>
</thead>
</table>
| The BlackBerry Administration Service is configured to use static ports when it connects to the BlackBerry Configuration Database server, but the BlackBerry Configuration Database server uses a dynamic port. | Configure the BlackBerry Administration Service to use a dynamic port for the BlackBerry Configuration Database.  
1. On the computer that hosts the BlackBerry Enterprise Server Express component, on the taskbar, click **Start > All Programs > BlackBerry Enterprise Server**.  
2. Right-click **BlackBerry Server Configuration** and select **Run as administrator**.  
3. On the **Database Connectivity** tab, select the **Use dynamic ports or specify SQL port** check box.  
4. Click **OK**.  
5. In the Windows Services, restart the services for the BlackBerry Administration Service. |

The BlackBerry Administration Service pool name is the same as the FQDN of the host computer

Possible cause

A DNS record was not created before a BlackBerry Administration Service instance was installed.

Possible solution

1. Create the DNS record for the BlackBerry Administration Service instance.
2. On the computer that hosts the BlackBerry Enterprise Server Express component, on the taskbar, click Start > All Programs > BlackBerry Enterprise Server.

3. Right-click BlackBerry Server Configuration and select Run as administrator.

4. On the Administration Service - High Availability tab, in the Pool name field, type the name of the BlackBerry Administration Service pool.

5. In the Windows Services, restart the services for the BlackBerry Administration Service.

The text in the license agreement is not readable

Possible cause
You have not installed the appropriate languages and text services on the computer that you use to install the BlackBerry Enterprise Server Express.

Possible solution
Verify that you installed the appropriate languages and text services on the computer that you use to install the BlackBerry Enterprise Server Express.
To read the following guides or additional related material, visit http://www.blackberry.com/go/serverdocs.

<table>
<thead>
<tr>
<th>Guide</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>What’s New in BlackBerry Enterprise Server 5.0 SP4 Job Aid</em></td>
<td>• Summary of new features</td>
</tr>
<tr>
<td><em>BlackBerry Enterprise Server Express Update Guide</em></td>
<td>• Summary of updates to the administrator guides for BlackBerry Enterprise Server Express 5.0 SP4</td>
</tr>
<tr>
<td><em>BlackBerry Enterprise Server Express Release Notes</em></td>
<td>• Description of known issues and potential workarounds</td>
</tr>
<tr>
<td><em>BlackBerry Enterprise Server Express Upgrade Guide</em></td>
<td>• System requirements</td>
</tr>
<tr>
<td></td>
<td>• Upgrade instructions</td>
</tr>
<tr>
<td><em>BlackBerry Enterprise Server Policy Reference Guide</em></td>
<td>• Descriptions of available IT policy rules and application control policy rules</td>
</tr>
<tr>
<td></td>
<td>• Descriptions of Wi-Fi configuration settings and VPN configuration settings</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td></td>
</tr>
<tr>
<td><strong>AES</strong></td>
<td>Advanced Encryption Standard</td>
</tr>
<tr>
<td><strong>AJAX</strong></td>
<td>Asynchronous JavaScript and XML</td>
</tr>
<tr>
<td><strong>BlackBerry CAL</strong></td>
<td>A BlackBerry Client Access License (BlackBerry CAL) limits how many users you can add to a BlackBerry Enterprise Server.</td>
</tr>
<tr>
<td><strong>BlackBerry Domain</strong></td>
<td>A BlackBerry Domain consists of the BlackBerry Configuration Database with its users and any BlackBerry Enterprise Server instances that connect to it.</td>
</tr>
<tr>
<td><strong>BlackBerry MDS</strong></td>
<td>BlackBerry Mobile Data System</td>
</tr>
<tr>
<td><strong>CAS</strong></td>
<td>Client Access Server</td>
</tr>
<tr>
<td><strong>CDMA</strong></td>
<td>Code Division Multiple Access</td>
</tr>
<tr>
<td><strong>CDO</strong></td>
<td>Collaboration Data Object</td>
</tr>
<tr>
<td><strong>DMZ</strong></td>
<td>A demilitarized zone (DMZ) is a neutral subnetwork outside of an organization's firewall. It exists between the trusted LAN of the organization and the untrusted external wireless network and public Internet.</td>
</tr>
<tr>
<td><strong>DNS</strong></td>
<td>Domain Name System</td>
</tr>
<tr>
<td><strong>FQDN</strong></td>
<td>fully qualified domain name</td>
</tr>
<tr>
<td><strong>HTTP</strong></td>
<td>Hypertext Transfer Protocol</td>
</tr>
<tr>
<td><strong>HTTPS</strong></td>
<td>Hypertext Transfer Protocol over Secure Sockets Layer</td>
</tr>
<tr>
<td><strong>IIS</strong></td>
<td>Internet Information Services</td>
</tr>
<tr>
<td><strong>IP</strong></td>
<td>Internet Protocol</td>
</tr>
<tr>
<td><strong>IP address</strong></td>
<td>An Internet Protocol (IP) address is an identification number that each computer or mobile device uses when it sends or receives information over a network, such as the Internet. This identification number identifies the specific computer or mobile device on the network.</td>
</tr>
<tr>
<td><strong>JDK</strong></td>
<td>Java Development Kit</td>
</tr>
<tr>
<td><strong>JRE</strong></td>
<td>Java Runtime Environment</td>
</tr>
<tr>
<td><strong>LAN</strong></td>
<td>local area network</td>
</tr>
<tr>
<td><strong>LDAP</strong></td>
<td>Lightweight Directory Access Protocol</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MAPI</td>
<td>Messaging Application Programming Interface</td>
</tr>
<tr>
<td>messaging server</td>
<td>A messaging server sends and processes messages and provides collaboration services, such as updating and communicating calendar and address book information.</td>
</tr>
<tr>
<td>NIC</td>
<td>network interface card</td>
</tr>
<tr>
<td>NSPI</td>
<td>Name Service Provider Interface</td>
</tr>
<tr>
<td>RAID</td>
<td>redundant array of independent (or inexpensive) disks</td>
</tr>
<tr>
<td>SNMP</td>
<td>Simple Network Management Protocol</td>
</tr>
<tr>
<td>SQL</td>
<td>Structured Query Language</td>
</tr>
<tr>
<td>SRP</td>
<td>Server Routing Protocol</td>
</tr>
<tr>
<td>SSL</td>
<td>Secure Sockets Layer</td>
</tr>
<tr>
<td>TCP</td>
<td>Transmission Control Protocol</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol (TCP/IP) is a set of communication protocols that is used to transmit data over networks, such as the Internet.</td>
</tr>
<tr>
<td>TLS</td>
<td>Transport Layer Security</td>
</tr>
<tr>
<td>Triple DES</td>
<td>Triple Data Encryption Standard</td>
</tr>
<tr>
<td>UDP</td>
<td>User Datagram Protocol</td>
</tr>
<tr>
<td>VPN</td>
<td>virtual private network</td>
</tr>
<tr>
<td>WAN</td>
<td>wide area network</td>
</tr>
<tr>
<td>XML</td>
<td>Extensible Markup Language</td>
</tr>
</tbody>
</table>
©2012 Research In Motion Limited. All rights reserved. BlackBerry®, RIM®, Research In Motion®, and related trademarks, names, and logos are the property of Research In Motion Limited and are registered and/or used in the U.S. and countries around the world.

Safari is a trademark of Apple Inc. Google Chrome is a trademark of Google Inc. IBM, Lotus, and Sametime are trademarks of International Business Machines Corporation. Intel and Xeon are trademarks of Intel Corporation. Microsoft, Active Directory, ActiveX, Hyper-V, Internet Explorer, Lync, Outlook, SQL Server, Visual C++, Windows, Windows Media, Windows Server, and Windows Vista are trademarks of Microsoft Corporation. Mozilla and Firefox are trademarks of Mozilla Foundation. Java, JavaScript, JDK, and JRE are trademarks of Oracle and/or its affiliates. RSA is a trademark of RSA Security. VMware vSphere is a trademark of VMware, Inc. All other trademarks are the property of their respective owners.

This documentation including all documentation incorporated by reference herein such as documentation provided or made available at www.blackberry.com/go/docs is provided or made accessible "AS IS" and "AS AVAILABLE" and without condition, endorsement, guarantee, representation, or warranty of any kind by Research In Motion Limited and its affiliated companies ("RIM") and RIM assumes no responsibility for any typographical, technical, or other inaccuracies, errors, or omissions in this documentation. In order to protect RIM proprietary and confidential information and/or trade secrets, this documentation may describe some aspects of RIM technology in generalized terms. RIM reserves the right to periodically change information that is contained in this documentation; however, RIM makes no commitment to provide any such changes, updates, enhancements, or other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software, products or services including components and content such as content protected by copyright and/or third-party websites (collectively the "Third Party Products and Services"). RIM does not control, and is not responsible for, any Third Party Products and Services including, without limitation the content, accuracy, copyright compliance, compatibility, performance, trustworthiness, legality, decency, links, or any other aspect of Third Party Products and Services. The inclusion of a reference to Third Party Products and Services in this documentation does not imply endorsement by RIM of the Third Party Products and Services or the third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN, ARE HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR PROVINC. SOME JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND CONDITIONS. TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE DOCUMENTATION TO THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE
HEREBY LIMITED TO NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM THAT IS THE SUBJECT OF THE CLAIM.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL RIM BE LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT, CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA, FAILURES TO TRANSMIT OR RECEIVE ANY DATA, PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH RIM PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF RIM PRODUCTS OR SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT SUCH DAMAGES WERE FORESEEN OR UNFORESEEN, AND EVEN IF RIM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, RIM SHALL HAVE NO OTHER OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY CONTAINED HEREIN; AND (B) TO RIM AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED RIM DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR, EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF RIM OR ANY AFFILIATES OF RIM HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that your airtime service provider has agreed to support all of their features. Some airtime service providers might not offer Internet browsing functionality with a subscription to the BlackBerry® Internet Service. Check with your service provider for availability, roaming arrangements, service plans and features. Installation or use of Third Party Products and Services with RIM’s products and services may require one or more patent, trademark, copyright, or other licenses in order to avoid infringement or violation of third party rights. You are solely responsible for determining whether to use Third Party Products and Services and if any third party licenses are required to do so. If required you are responsible for acquiring them. You should not install or use Third Party Products and Services until all necessary licenses have been acquired. Any Third Party Products and Services that are provided with RIM’s products and services are provided as a convenience to you and are provided "AS IS" with no express or implied conditions, endorsements, guarantees, representations, or warranties of any kind by RIM and RIM assumes no liability whatsoever, in relation thereto. Your use of Third Party Products and Services shall be governed by and subject to you agreeing to the terms of separate licenses and other agreements applicable thereto with third parties, except to the extent expressly covered by a license or other agreement with RIM.
Certain features outlined in this documentation require a minimum version of BlackBerry Enterprise Server, BlackBerry Desktop Software, and/or BlackBerry Device Software.

The terms of use of any RIM product or service are set out in a separate license or other agreement with RIM applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN AGREEMENTS OR WARRANTIES PROVIDED BY RIM FOR PORTIONS OF ANY RIM PRODUCT OR SERVICE OTHER THAN THIS DOCUMENTATION.

Certain features outlined in this documentation might require additional development or Third Party Products and Services for access to corporate applications.


This product includes software developed by the Apache Software Foundation (www.apache.org/) and/or is licensed pursuant to one of the licenses listed at (www.apache.org/licenses/). For more information, see the NOTICE.txt file included with the software.

Research In Motion Limited
295 Phillip Street
Waterloo, ON N2L 3W8
Canada

Research In Motion UK Limited
200 Bath Road
Slough, Berkshire SL1 3XE
United Kingdom

Published in Canada